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          Adobe Acrobat Reader  
 

Finding Words 
 

You can use the Find command to find a complete word or part of a word in the current PDF 

document.  Acrobat Reader looks for the word by reading every word on every page in the file, 

including text in form fields. 
 

To find a word using the Find command: 
 

1. Click the Find button (Binoculars), or choose Edit > Find. 

2. Enter the text to find in the text box. 

3. Select search options if necessary: 

Match Whole Word Only finds only occurrences of the complete word you enter in 

the box.  For example, if you search for the word stick, the words tick and sticky will 

not be highlighted. 

 

Match Case finds only words that contain exactly the same capitalization you enter in 

the box. 

 

Find Backwards starts the search from the current page and goes backwards through 

the document. 

4. Click Find.  Acrobat Reader finds the next occurrence of the word. 

        

To find the next occurrence of the word, Do one of the following: 

            

            Choose Edit > Find Again  

            Reopen the find dialog box, and click Find Again.  

            (The word must already be in the Find text box.) 

 

Copying and pasting text and graphics to another application 
 

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it 

into another application such as a word processor.  You can also paste text into a PDF 

document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you 

can switch to another application and paste it into another document.   

 

Note:  If a font copied from a PDF document is not available on the system displaying the 

copied text, the font cannot be preserved.  A default font  is substituted. 
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To select and copy it to the clipboard: 

1. Select the text tool T, and do one of the following: 

       To select a line of text, select the first letter of the sentence or phrase and drag to 

       the last letter.   

 

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option 

(Mac OS) as you drag across the width of the document.  

        

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command 

(Mac OS) as you drag the length of the document. 

         

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text 

on the current page is selected.  In Continuous or Continuous – facing mode, most of the text 

in the document is selected.  When you release the mouse button, the selected text is 

highlighted.  To deselect the text and start over, click anywhere outside the selected text.   

The Select All command will not select all the text in the document.  A workaround for this 

(Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected 

text to the clipboard. 

 

2. To view the text, choose Window > Show Clipboard 

 

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the 

Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose 

Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows 

Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK. 
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POLICY ADVISORY COUNCIL FARE COORDINATION AND INTEGRATION 1 

SUBCOMMITTEE 2 

THURSDAY, JULY 30, 2020, 10:05 AM 3 

 4 

RANDI KINMAN: THANK YOU. CAN WE HAVE THE ANNOUNCEMENT PLEASE? 5 

DUE TO COVID-19, THIS MEETING WILL BE CONDUCTED AS A ZOOM 6 

WEBINAR. PURSUANT TO THE PROVISIONS OF THE GOVERNOR'S 7 

EXECUTIVE ORDER N-29-20, WHICH SUSPENDS CERTAIN REQUIREMENTS 8 

OF THE BROWN ACT. THIS MEETING WILL BE WEBCAST ON THE MTC WEB 9 

SITE. I WILL CALL UPON COMMISSIONERS, PRESENTERS, STAFF, AND 10 

OTHER SPEAKERS BY NAME AND ASK THAT THEY SPEAK CLEARLY AND 11 

RESTATE THEIR NAMES BEFORE GIVING COMMENTS OR REMARKS. PERSONS 12 

PARTICIPATING VIA ZOOM AND WEBCAST WITH THEIR CAMERAS ENABLED 13 

ARE REMINDED THEIR ACTIVITIES ARE VISIBLE TO VIEWERS. 14 

COMMISSIONERS AND MEMBERS OF THE PUBLIC PARTICIPATING BY ZOOM, 15 

WISHING TO SPEAK SHOULD USE THE RAISED HAND FEATURE OR DIAL 16 

STAR NINE AND I WILL CALL UPON YOU AT THE APPROPRIATE TIME. 17 

TELECONFERENCE ATTENDEES WILL BE CALLED UPON BY THE LAST FOUR 18 

DIGITS OF THEIR PHONE NUMBERS. AND IT IS REQUESTED THAT PUBLIC 19 

SPEAKERS RESTATE THEIR NAMES AND ORGANIZATIONS, BUT PROVIDING 20 

SUCH INFORMATION IS VOLUNTARY. MEMBERS OF THE PUBLIC WISHING 21 

TO ADDRESS THIS BODY WERE ASKED TO SUBMIT COMMENTS IN WRITING 22 

AT INFO@BAYAREAMETRO.GOV. WRITTEN COMMENTS RECEIVED WILL BE 23 

POSTED TO THE ONLINE AGENDA AND ENTERED INTO THE RECORD BUT 24 

WILL NOT BE READ OUT LOUD. IF AUTHORS OF THE WRITTEN 25 
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CORRESPONDENCE WOULD LIKE TO SPEAK, THEY ARE FREE TO DO ON THE 1 

REFERENCED AGENDA ITEM OR ANY TOPIC THEY CHOOSE. SPEAKERS 2 

SHOULD RAISE THEIR HAND, AND I WILL CALL UPON THEM AT THE 3 

APPROPRIATE TIME. A ROLL CALL VOTE WILL BE TAKEN FOR ALL 4 

ACTION ITEMS. THE CHAT FEATURE IS ACTIVE, HOWEVER, PLEASE BE 5 

AWARE THAT ANYTHING TYPED INTO THE CHAT WILL BE SUBJECT TO 6 

PUBLIC DISCLOSURE. THE CHAT FEATURE IS NOT AVAILABLE TO 7 

ATTENDEES. IN ORDER TO GET THE FULL ZOOM EXPERIENCE, PLEASE 8 

MAKE SURE YOUR APPLICATION IS UP TO DATE.  9 

 10 

RANDI KINMAN: THANK YOU. WOULD STAFF LIKE TO MAKE ANY OPENING 11 

REMARKS BEFORE I WELCOME PEOPLE IN?  12 

 13 

WILLIAM BACON: THANK YOU. THIS IS BILL BACON, I AM THE CO 14 

PARTNER FOR THE FARE INTEGRATION STUDY. I WANT TO WELCOME 15 

EVERYONE TO THIS FIRST MEETING. WE'RE GOING TO BE HOPING TO 16 

GET QUITE A BIT OF FEEDBACK FROM ALL OF YOU TODAY AND WE 17 

APPRECIATE YOU TAKING THE TYPE OUT OF YOUR SCHEDULES TO LEARN 18 

ABOUT THIS PROJECT AND TO HELP US MAKE THE PROJECT AS 19 

SUCCESSFUL AS IT CAN BE IN THE COMING YEAR. THAT'S ALL I WANT 20 

TO SAY BUT WE LOOK FORWARD TO A ROBUST CONVERSATION TODAY. 21 

THANK YOU.  22 

 23 

RANDI KINMAN: MICHAEL?  24 

 25 



               July 30, 2020 

 5 

SPEAKER: NO. NOTHING TO ADD RIGHT NOW. THANK YOU BILL, AND TO 1 

EVERYONE FOR TAKING THE TIME OUT TODAY. TO INTRODUCE MYSELF MY 2 

NAME IS MIKE EISEMAN, FINANCING PLANNING MANAGER FOR BART AND 3 

CO-PROJECT MANAGER WITH BILL.  4 

 5 

RANDI KINMAN: THANK YOU. I AM RANDI KINMAN. AND AS CHAIR OF 6 

THE POLICY ADVISORY COUNCIL. I WOULD LIKE TO THANK ALL OF YOU 7 

FOR PARTICIPATING IN THIS. I'M GLAD WE FINALLY CAME TOGETHER 8 

TO ADDRESS THIS ISSUE. OUR COMMITTEES HAVE BEEN WORKING ON FOR 9 

TEN YEARS AND OTHER GROUPS HAVE BEEN DOING THE SAME THING. 10 

THIS IS AN EXCITING TIME IN MANY RESPECTS BECAUSE WHEN THIS 11 

COMMITTEE WAS AUTHORIZED WE HAD NO IDEA A PANDEMIC WAS GOING 12 

TO BE UPON US AND THAT OUR TRANSIT SYSTEMS WOULD BE IN A WORLD 13 

OF HURT AND NEAR COLLAPSE, AND THIS COMMITTEE'S WORK TIES INTO 14 

OUR RECOVERY EFFORTS SO IT'S MORE IMPORTANT NOW THAN EVER THAT 15 

WE GET THIS WORK DONE AND GET IT DONE QUICKLY AND CORRECTLY. 16 

WHILE THIS COMMITTEE IS A SUBCOMMITTEE OF A POLICY ADVISORY 17 

COUNCIL THEY CHAIR, YOU WILL BE ACTING AS A STANDALONE BODY 18 

GOING IN SEVERAL DIRECTIONS ALONG THE WAY. YOU ARE HEAR FROM 19 

OTHER RELATED COMMITTEES EITHER FROM BART OR MTC AND ABAG AND 20 

IF YOU ARE INTERESTED IN FOLLOWING THOSE PLEASE LET BIRTH 21 

ACTUALLY LET MARTHA KNOW AND SHE WILL ADD YOU TO THE LIST OF 22 

PEOPLE WHO GET NOTIFICATIONS FOR THESE MEETINGS AND YOU WILL 23 

GET THE AGENDA SENT AND EVERYTHING ELSE. AS A SUBCOMMITTEE OF 24 

THE POLICY ADVISORY COUNCIL, THIS IS A LITTLE TRICKY, BECAUSE 25 
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WE'RE A HYBRID. I HAVE ZERO INTENTION OF RUNNING THESE 1 

MEETINGS AND ADDING TO MY PERSONAL WORKLOAD. SO I'M GOING TO 2 

BE APPOINTING ADINA LEVIN AS CHAIR AND WENDI KALLINS AS VICE 3 

CHAIR WHICH WILL ALLOW THE MEETINGS TO FLOW PROPERLY AND TO 4 

HAVE SOMETHING WHO CAN REPORT IN MULTIPLE DIRECTIONS. AGAIN, I 5 

WANT TO THANK ALL OF YOU FOR PARTICIPATING. I LOOK FORWARD TO 6 

WORKING WITH YOU AS A FELLOW COMMITTEE MEMBER OVER THE NEXT 7 

YEAR, AND WE'LL NOW TURN THE MEETING OVER TO ADINA FOR ITEM 8 

NUMBER TWO, WHICH IS THE ROLL CALL. THANK YOU. ADINA IT'S 9 

YOURS.  10 

 11 

ADINA LEVIN, CHAIR: THANK YOU TO EVERYONE FOR COMING TO THIS 12 

MEETING WHICH RANDI NOTED, IS LONG AWAITED AND THERE ARE A LOT 13 

OF PEOPLE IN THE LEAD UP WHO MADE THIS TEAM POSSIBLE AND 14 

BRINGING FORWARD THIS BOARD'S CONSIDERATION, AND WOULD VERY 15 

MUCH, AS THE FIRST MEETING, WHICH I AM CHAIRING, WOULD 16 

APPRECIATE ANY SUPPORT BY STAFF AND BY POLICY ADVISORY COUNCIL 17 

CHAIR KINMAN TO HELP IN VERIFYING IF I'M DOING ANY OF THIS 18 

WRONG. SO AS WE GET STARTED, IS -- NOW THE POINT THAT WE ASK 19 

THE CLERK TO READ PUBLIC COMMENTS RECEIVED, ASSOCIATED WITH 20 

THIS ITEM, INTO THE RECORD, AND ALSO IF ANYONE HAS -- ANY 21 

MEMBERS OF THE PUBLIC HAVE QUESTIONS PLEASE USE THE RAISED 22 

HAND FEATURE OR DIAL STAR NINE TO COMMENT.  23 

 24 

RANDI KINMAN: WE NEED TO DO ROLL CALL FIRST.  25 
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 1 

ADINA LEVIN, CHAIR: OKAY. FIRST THING WE NEED TO DO IS ROLL 2 

CALL AND CONFIRM QUORUM BY THE CLERK.  3 

 4 

CLERK OF THE BOARD: THANK YOU. BOB ALLEN? JIM BLACKSTEN? CAT 5 

CARTER?  6 

 7 

SPEAKER: HERE.  8 

 9 

CLERK OF THE BOARD: ABIGAIL COCHRAN?  10 

 11 

SPEAKER: HERE.  12 

 13 

CLERK OF THE BOARD: ANNE OLIVIA ELDRED?  14 

 15 

SPEAKER: HERE.  16 

 17 

CLERK OF THE BOARD: IAN GRIFFITHS?  18 

 19 

SPEAKER: HERE.  20 

 21 

CLERK OF THE BOARD: TISHA DEE?  22 

 23 

SPEAKER: TISHA DEE HARTMAN.  24 

 25 
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SPEAKER: HERE.  1 

 2 

CLERK OF THE BOARD: WENDI KALLINS IS EXCUSED.  3 

 4 

CLERK OF THE BOARD: JONATHON KASS?  5 

 6 

SPEAKER: HERE.  7 

 8 

CLERK OF THE BOARD: RANDI KINMAN?  9 

 10 

RANDI KINMAN: PRESENT. AND PLEASE NOTE JIM E. BLACKSTEN IS NO 11 

LONGER HERE.  12 

 13 

CLERK OF THE BOARD: GWEN LITVAK? MONICA MALLON?  14 

 15 

SPEAKER: HERE.  16 

 17 

CLERK OF THE BOARD: ADRIAN MENDOZA?  18 

 19 

ADRIAN MENDOZA: HERE.  20 

 21 

CLERK OF THE BOARD: THANK YOU. STEPHANIE MCNALLY? AND BRIAN 22 

STANKE?  23 

 24 

SPEAKER: HERE.  25 
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 1 

CLERK OF THE BOARD: QUORUM IS PRESENT.  2 

 3 

ADINA LEVIN, CHAIR: OKAY. WE'RE GOING TO ITEM 3, MEMBERSHIP 4 

ROSTER AND APPOINTMENT OF THE CHAIR AND VICE CHAIR FOR THE 5 

POLICY ADVISORY COUNCIL FARE COORDINATION AND INTEGRATION 6 

SUBCOMMITTEE, PRESENTED BY BILL BACON. I THINK WE WILL HAVE 7 

THE PRESENTATION FIRST, THEN DO THE PUBLIC COMMENT.  8 

 9 

WILLIAM BACON: THIS ITEM IS A MEMO AND A TEMPLATE OF THE 10 

ROSTER IN YOUR PACKET. RANDI NOTED A MOMENT AGO, THIS NEW 11 

SUBCOMMITTEE IS HOUSED UNDER MTC'S POLICY ADVISORY COUNCIL BUT 12 

IT'S UNIQUE IN THAT IT INCLUDES BOTH MEMBERS OF THE POLICY 13 

ADVISORY COUNCIL AS WELL AS OTHER STAKEHOLDERS FOR A VARIETY 14 

OF DIFFERENT CONSTITUENCIES AROUND THE BAY AREA. THIS ITEM 15 

LISTS WHO IS INVITED TO PARTICIPATE IN THE MEETING TODAY BASED 16 

ON A FRAMEWORK THAT WAS APPROVED BY THE POLICY ADVISORY 17 

COUNCIL IN FEBRUARY OF THIS YEAR. YOU WILL SEE THE ROSTER AS 18 

WE -- AS IT STOOD, I SHOULD SAY, EARLIER THIS WEEK, AND THERE 19 

ARE SEVERAL OUTSTANDING INVITATIONS FOR DIFFERENT 20 

ORGANIZATIONS TO PARTICIPATE AND THOSE CHARACTERIZATIONS HAVE 21 

YET TO CONFIRM THAT THEY WILL BE ABLE TO PARTICIPATE. OUR HOPE 22 

IS THEY WILL BE ABLE TO PARTICIPATE IN FUTURE MEETINGS IF 23 

THEY'RE NOT ABLE TO BE HERE TODAY. THIS ITEM IS AN INFORMATION 24 

ITEM SO THAT ALL OF THE SUBCOMMITTEE MEMBERS CAN SEATS 25 
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MEMBERSHIP ROSTER FOR THE SUBCOMMITTEE AND JUST PROVIDE A 1 

LITTLE BIT OF BACKGROUND TO THOSE OF YOU WHO ARE NOT ON THE 2 

POLICY ADVISORY COUNCIL ITSELF ABOUT HOW THIS BODY CAME TO BE. 3 

I AM HAPPY TO ANSWER ANY QUESTIONS THAT YOU HAVE.  4 

 5 

ADINA LEVIN, CHAIR: ALL RIGHT. I AM NOT SEEING ANY QUESTIONS 6 

OR RAISED HANDS FROM PANELISTS. IF THAT IS SELF ESTIMATED 7 

EVIDENT AND DOESN'T ENTAIL ANY QUESTIONS. WOULD THE COLLECT 8 

READ INTO THE RECORD ANY COMMENTS RECEIVED AND IF THE PUBLIC 9 

WISHES TO SPEAK PLEASE DIAL STAR NINE TO COMMENT ON THIS ITEM.  10 

 11 

CLERK OF THE BOARD: NO MEMBERS OF THE PUBLIC WITH THEIR HANDS 12 

RAISED AT THIS MOMENT AND NO PUBLIC COMMENT WAS SUBMITTED ON 13 

THIS ITEM.  14 

 15 

ADINA LEVIN, CHAIR: OKAY. THEN WE CAN MOVE ON TO AGENDA ITEM 16 

NUMBER FOUR, WHICH IS UPDATE AND DISCUSSION ON THE FARE 17 

COORDINATION AND INTEGRATION STUDY AND BUSINESS CASE, AND THIS 18 

WILL BE PRESENTED BY MICHAEL EISEMAN, WILLIAM BACON, AND LISA 19 

RAFFETTO. TURNING IT OVER TO STAFF FOR PRESENTATION PRIOR TO 20 

COMMENT AND DISCUSSION.  21 

 22 

MICHAEL EISEMAN: MIKE EISEMAN HERE. I WILL GET THIS STARTED 23 

FOR THE PRESENTATION. HOW DO WE DISPLAY THE POWERPOINT DECK? 24 

CAN SOMEONE HELP WITH THAT? AH, GREAT. OKAY. SO WE HAVE A 25 
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POWERPOINT DECK HERE. TO THE EXTENT POSSIBLE, WE WANT TO KEEP 1 

OUR REMARKS BRIEF AND EMPHASIZE INPUT AND DISCUSSION FROM THE 2 

GROUP HERE. WE HAVE SORT OF THREE MAIN TOPIC AREAS THAT WE 3 

WANT TO INTRODUCE AND SEEK YOUR INPUT AND DISCUSSION ON. FIRST 4 

SET OF INFORMATION IS JUST TO CATCH US ALL UP ON THE PURPOSE, 5 

THE GOALS, AND THE GENERAL CONTRACTS FOR THIS STUDY. AND THE 6 

STRUCTURE OF THE STUDY IT'S SORT OF MORE COMPLEX THAN MANY 7 

PLANNING EFFORTS. AND MANY OF YOU SOME OF THAT AND PERHAPS NOT 8 

EVERYONE. SO LET'S GET CAUGHT UP ON THAT FIRST. THEN THERE IS 9 

TWO SUBSTANTIVE AREAS BEYOND THAT. ONE IS DISCUSSION OF A 10 

PROBLEM STATEMENT FOR THIS STUDY. WHAT ARE THE ISSUES WITH 11 

FARES THAT WE'RE ATTEMPTING TO ADDRESS, WHERE DO THEY SIT IN 12 

THE CONTEXT OF THE OTHER REGIONAL TRANSPORTATION CHALLENGES 13 

AND GOALS. AND THAT'S BEEN DISCUSSED ALREADY BY THE SORT OF 14 

TASK FORCE THAT ULTIMATELY OWNS THIS STUDY BUT ON A 15 

PRELIMINARY BASIS, AND CERTAINLY IT NEEDS INPUT AND DISCUSSION 16 

FROM THIS GROUP. AND THEN THE THIRD ITEM IS A DISCUSSION OF 17 

WHAT WE'RE CALLING USER RESEARCH. SO AN ATTEMPT TO GET BROADER 18 

INPUT FROM A LARGER GROUPS OF FOLKS. AND THE INITIAL IDEA FOR 19 

THIS STUDY INCLUDED SOME INNOVATION THERE, TRYING TO USE SOME 20 

SORT OF MORE INNOVATIVE QUALITATIVE METHODS TO SEEK INPUT FROM 21 

FOLKS ACTUALLY OUT IN THE WORLD AND RIDING THE TRAINS, IN 22 

CONTEXT, AND BUSES, EXCUSE ME, SHOWING MY BIAS THERE AS A BART 23 

PERSON. AND WE -- THE PANDEMIC HAS CERTAINLY THROWN A WRENCH 24 

INTO THE WORKS AS TO THAT APPROACH AND WE'RE IN THE PROCESS OF 25 



               July 30, 2020 

 12 

RETHINKING HOW TO GET THE INPUT WE NEED FROM A BROADER GROUP 1 

OF PEOPLE. AND WE WANT -- WE'RE HOPING TO ASK FOR YOUR INPUT 2 

AND DISCUSSION ON HOW TO APPROACH THAT PART OF THE PROJECT. SO 3 

MAYBE WITH THAT, I WILL TURN IT OVER TO BILL TO TALK ABOUT THE 4 

CONTEXT, AND BACKGROUND ON THE STUDY.  5 

 6 

WILLIAM BACON: THANKS MIKE, IF WE CAN GO AHEAD TO THE NEXT 7 

SLIDE, PLEASE. AS MIKE MENTIONED, THE FIRST PORTION OF THIS 8 

PRESENTATION IS REALLY TO PROVIDE A BIT OF CONTEXT AND 9 

BACKGROUND ABOUT WHAT THE FARE COORDINATION AND INTEGRATION 10 

STUDY IS INVESTIGATING, CONTEXT FOR FARE POLICY IN THE BAY 11 

AREA AND SORT OF HOW WE GOT TO WHERE WE ARE TODAY WITH THIS 12 

PROJECT. I DO WANT TO CALL YOUR ATTENTION TO TWO ATTACHMENTS 13 

THAT WERE INCLUDED WITH THIS ITEM. ONE WAS THE SCOPE OF WORK 14 

FOR THE PROJECT AND THAT IS WHAT OUR CONSULTANT TEAM WHICH IS 15 

A TEAM CALLED STEER, THAT IS THE WORK THE CONSULTANT GROUP 16 

RESPONDED TO, AND THAT'S A STARTING POINT FOR PEOPLE TO 17 

UNDERSTAND THE TYPES OF QUESTIONS WE ARE ASKING AND A SECOND 18 

ATTACHMENT WHICH IS A LARGE TABLE THAT SHOWS THE DIFFERENT 19 

FARES FOR A SINGLE RIDE TRIP IN THE BAY AREA. IT WAS UPDATED A 20 

FEW MONTHS AGO SO JUST NOTE THAT AS A CAVEAT, BUT THAT SHOWS 21 

JUST SOME OF THE WIDE RANGE OF COMPLEXITY OF THE FARES THAT 22 

EXIST FOR A SINGLE RIDE TRIP IN THE BAY AREA. THOSE ARE GOOD 23 

REFERENCE DOCUMENTS AND I'LL WALK US THROUGH THE FIRST FEW 24 

SLIDES AND IF FOLKS HAVE QUESTIONS PLEASE FEEL FREE TO RAISE 25 
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YOUR HAND OR TO COMMUNICATE, IF YOU HAVE A QUESTION WE DO WANT 1 

THIS TO BE A FAIRLY INTERACTIVE CONVERSATION TODAY, AND NOT 2 

JUST A LONG PRESENTATION WITH FEEDBACK AT THE END. I THINK A 3 

FAIR POINT TO START IS WHAT IS FARE POLICY AND WHAT DO WE MEAN 4 

BY THAT? FARE POLICY ARE THE RULES THAT DEFINE HOW MUCH PEOPLE 5 

PAY TO USE PUBLIC TRANSIT AND THAT CAN BE BROKEN DOWN TO 6 

SEVERAL DIFFERENT CATEGORIES NOTED HERE: THE STRUCTURE OF THE 7 

FARES; SO HOW IS THE PRICE SET IN DETERMINING WHAT IT COST TO 8 

TAKE A TRIP. WHAT IS THE PRICE ITSELF: WHAT DOES IT COST TO 9 

RIGHT TRANSIT, AND THIS SINGLE FARE RIDE COST EXCLUDING 10 

DISCOUNTS OR PASSES. WHAT ARE THE WEIGHS OR PAYMENT OPTIONS 11 

THAT PEOPLE CAN PAY THEIR FARE? DO THEY PAY THROUGH A SINGLE 12 

RIDE TICKET. IS THERE A CAP WHERE IF YOU PAY A CERTAIN AMOUNT 13 

PER DAY THAT GIVES YOU LOTS OF OPTIONS, SO THERE ARE LOTS OF 14 

METHODS FOR HOW PAYMENTS HAPPEN. AND DISCOUNTED FARES: DO 15 

RIDERS QUALIFY BASED ON DISCOUNTED FARE BASED ON AGE OR 16 

CHARACTERISTIC AND HOW IS THAT DETERMINED. GO TO THE NEXT 17 

SLIDE. THIS TABLE BREAKS DOWN THE COMPONENTS INTO MAYBE 18 

SLIGHTLY EASIER FORM FORMAT TO THINK ABOUT IN OUR REGION WITH 19 

TWO DOZEN OPERATORS THAT OPERATE DIFFERENT TYPES OF TRANSIT 20 

SERVICE WE CAN THINK ABOUT FARES AS A LOCAL TRANSIT FARE, A 21 

REGIONAL TRANSIT FARE FOR TRIPS CROSSING COUNTY LINES OR 22 

TRAVELING A GREATER DISTANCE. AS I MENTIONED ON THE PREVIOUS 23 

SLIDES, ARE THERE DISCOUNTS THAT ARE APPLIED TO THOSE FARES? 24 

IS THERE TIME BASED PRICING WHERE IF YOU TRAVEL ON A CERTAIN 25 
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DAY OR CERTAIN TIME, ARE THERE DISCOUNTS APPLIED. THIS ISN'T 1 

APPLIED IN THE BAY AREA BUT LOTS OF TRANSIT SYSTEMS IN THE BAY 2 

AREA AND AROUND THE WORLD OFFER TEMPORAL PRICING. HOW ARE 3 

TRANSFERS HANDLED IF YOU ARE HAVE TO TRANSFER BETWEEN BUSES 4 

WHAT IS THE WINDOW? IS THERE A SET AMOUNT OF TIME TO TRANSFER 5 

BETWEEN BUSES A LOT OF OUR SYSTEMS OFFER A 120 OR 90 MINUTE 6 

WINDOW WHERE YOU CAN TRANSFER OR FARE CREDITS IF YOU TRANSFER. 7 

AND LOYALTY INCENTIVES IF YOU REMAIN LOYAL TO A SYSTEM IN MANY 8 

CASES MONTHLY PASSES OR ANNUAL PASSES OFFERED ARE A LOYALTY 9 

SENSE PRODUCT IT ENCOURAGES A PASSENGER TO PAY AN UPFRONT COST 10 

AND THEN REMAIN A RIDER OF THAT SYSTEM. THERE ARE NO FURTHER 11 

BARRIERS TO USING THE SYSTEM. SO WHAT TYPE OF LOYALTY 12 

INCENTIVES EXIST IN THE FARE POLICY. WE CAN GO TO THE NEXT 13 

SLIDE PLEASE. SO FARE POLICY AFFECTS REALLY ALL ASPECTS OF THE 14 

TRANSIT SYSTEM. I THINK OBVIOUSLY IT IMPACTS THE REVENUE THAT 15 

OPERATORS HAVE TO OPERATE THE SYSTEMS AT ITS CORE FARES TO 16 

OPERATING THE SERVICE BUT BEYOND THAT IT'S EXTREMELY IMPORTANT 17 

TO ALL OTHER FACTORS NOTED ON THIS SLIDE HOW DO EXPERIENCE THE 18 

SYSTEM TRAVEL AROUND THE SYSTEM IN THE COMMUNITY-BASED ON 19 

WHAT'S OFFERED THAT AFFECTS RIDERSHIP AND HOW MANY PEOPLE USE 20 

TRANSIT WHERE THE SERVICE IS DESIGNED AND HOW IT'S PLANNED IS 21 

IMPACTED BY TYPES OF FARE PRODUCTS OFFERED SO THINK ABOUT 22 

INSTANCES IF YOU'RE MAKING A CONNECTION BETWEEN TWO DIFFERENT 23 

TRANSIT SYSTEMS THE WAY PEOPLE USE THOSE SYSTEMS MIGHT CHANGE 24 

BASED ON THE TYPE OF FARE PRODUCTS YOU'RE OFFERING. MARKETING 25 
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OF THE SYSTEM, THE FARES THAT ARE AVAILABLE FOR THE PUBLIC TO 1 

PURCHASE, AND TO USE, MAKER A BIG DIFFERENCE IN TERMS OF HOW 2 

YOU SELL THE TRANSIT SERVICE THAT IS AVAILABLE, AND HOW YOU 3 

LET PEOPLE KNOW THAT THAT SERVICE IS THERE. IT'S RELIABILITY. 4 

THAT MIGHT NOT SEEM AS INTUITIVE, BUT A FARE SYSTEM THAT HAS 5 

SIGNIFICANT BARRIERS TO TRANSFER IN BETWEEN BUSES OR TRANSFER 6 

BETWEEN OPERATORS CAN SLOW DOWN THE SERVICE, IN SOME 7 

CIRCUMSTANCES, AND THAT CAN IMPACT RELIABILITY. AND I THINK, 8 

OVERLAYING ALL OF THIS, ARE QUESTIONS ABOUT EQUITY, AND HOW 9 

OUR FARE POLICIES ACROSS THE BAY AREA IMPACT THE BE ABILITY OF 10 

ALL PEOPLE TO MAKE USE OF TRANSIT AND HAVE ACCESS TO 11 

OPPORTUNITY THAT TRANSIT PROVIDES. GO ON TO THE NEXT SLIDE. SO 12 

JUST TRYING TO SUMMARIZE A LITTLE BIT HERE, AT A VERY HIGH 13 

LEVEL, SOME OF THE FARE POLICIES THAT EXIST TODAY IN THE BAY 14 

AREA. WE HAVE NINE DIFFERENT LOCAL BUS FARES THAT ARE 15 

AVAILABLE ON THE CLIPPER CARD DEPENDING ON WHICH TRANSIT 16 

SYSTEM YOU'RE USING AND THOSE RANGE IN PRICE BETWEEN $1.50 AND 17 

$2.50. SO THAT MEANS IF YOU GO DOWN AND TRY TO GET LOCAL BUS 18 

SERVICE IN YOUR COMMUNITY DEPENDING WHERE YOU ARE IN THE 19 

REGION THERE ARE NINE DIFFERENT LOCAL BUS FARES YOU MIGHT PAY 20 

DEPENDING ON WHICH OPERATOR YOU'RE USING AND THAT'S THE PRICE 21 

RANGE IN BETWEEN, $1.50 AND $2.50 THAT DEPENDING ON WHERE YOU 22 

ARE IN THE REGION AND WHAT TYPE OF TRIP YOU'RE TAKING. LOOKING 23 

AT DISCOUNTS THAT WE OFFER ACROSS OUR SYSTEMS. THERE ARE 16 24 

DIFFERENT DISCOUNT RATES THAT ARE OFFERED FOR YOUTH. SO THAT 25 
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COULD BE A 50 PERCENT DISCOUNT, 20 PERCENT DISCOUNT, THE RATE 1 

ITSELF IS DIFFERENT DEPENDING ON WHICH OPERATOR YOU'RE ON. AND 2 

FOR SENIORS, THERE ARE 14 DIFFERENT RATES OF DISCOUNT THAT ARE 3 

OFFERED, DEPENDING ON WHICH OPERATOR YOU'RE ON. SO THIS IS 4 

SOMEWHAT DIFFICULT TO COMMUNICATE TO THE PUBLIC IN TERMS OF 5 

WHAT TYPE OF DISCOUNT YOU WOULD BE ENTITLED TO, DEPENDING ON 6 

YOUR CATEGORY. THEN FINALLY, THIS, ALL OF THE EXISTING FARE 7 

POLICIES IN THE REGION SUM UP TO REQUIRE ABOUT 20,000, WHAT WE 8 

CALL "BUSINESS RULES" IN THE CLIPPER SYSTEM. SO ON THE BACK 9 

END OF THE CLIPPER CARD IS TECHNOLOGY INFRASTRUCTURE THAT HAS 10 

EVERY FARE PRODUCT COMBINATION PROGRAMMED INTO IT SO IF YOU 11 

TAP YOUR CLIPPER CARD ON AN AC TRANSIT BUS THEN GET ON BART 12 

TRAIN TO TAKE BART FROM BERKELEY TO FREMONT THEN GET OFF TO 13 

VTA SERVICE, WHAT TYPE OF FARE DOES YOUR CLIPPER CARD NEED TO 14 

CHARGE YOU. AND IT TAKES ABOUT 20,000 POLICIES WITHIN THE 15 

CLIPPER CARD SYSTEM TO IMPLEMENT OUR CURRENT FARE POLICY 16 

SYSTEM. AND THAT LEVEL OF COMPLEXITY MEANS THAT IT'S HARDER 17 

FOR TRANSIT OPERATORS TO IMPLEMENT NEW FARE PRODUCTS AND 18 

INNOVATIVE IDEAS IN TERMS OF HOW THEY OFFER PRODUCTS TO THEIR 19 

CUSTOMERS, BECAUSE IT REQUIRES A COMPLICATE THE TECHNOLOGY 20 

IMPLEMENTATION ON THE BACK END. NOW ALL THAT IS SET TO CHANGE 21 

WITH THE NEXT GENERATION CLIPPER SYSTEM THAT'S COMING IN ITS 22 

FIRST SET OF WAVES LATER THIS YEAR BUT IN OUR CURRENT SYSTEM 23 

TODAY THAT'S WHAT IT TAKES. GO TO THE NEXT SLIDE PLEASE. SO 24 

THE JARGON HERE IS TECHNICAL AND I'LL TRY TO WALK US THROUGH 25 
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IT. BUT IF YOU WANT TO THINK ABOUT FARE POLICY AS SORT OF 1 

HAVING DIFFERENT METHODOLOGIES FOR HOW YOU COULD THINK ABOUT 2 

FARES, WE HAVE FOUR SORT OF MAIN DIFFERENT METHODOLOGIES THAT 3 

EXIST IN OUR REGION. WE HAVE SEVEN OPERATORS THAT USE A FLAT 4 

FARE FOR ALL TRIPS. AND THIS IS TYPICAL OF MANY SYSTEMS AROUND 5 

THE U.S., ESPECIALLY BUS OPERATORS. SO THIS MEANS ANY TRIP YOU 6 

TAKE, ANYWHERE IN THE SYSTEM OF THAT OPERATOR, YOU PAY A 7 

SINGLE FARE. SO A LOT OF OUR BUS OPERATORS USE THIS, SYSTEMS 8 

IN OTHER REGIONS LIKE NEW YORK CITY, NEW YORK CITY SUBWAY AND 9 

BUS SYSTEM ALWAYS USE A FLAT FARE. THERE IS A TWEAK ON THAT 10 

WHICH IS A FLAT FARE WITH WHAT WE'RE CALLING A "PREMIUM 11 

HYBRID" AND THAT IS CONSISTENT THAT NINE OPERATORS USE AND THE 12 

ONE ABOVE FLAT FARE FOR LOCAL TRIPS BUT IF THE OPERATOR OFFERS 13 

EXPRESS SERVICE OR REGIONAL SERVICE ON A BUS TYPICALLY, THERE 14 

IS A PREMIUM APPLIED TO THAT. AND A GOOD EXAMPLE OF THAT IS AC 15 

TRANSIT WHICH HAS A FLAT FARE FOR ALL OF THEIR SERVICE WITHIN 16 

THE EAST BAY CHARGES FOR PREMIUM FOR SERVICE FROM SAN 17 

FRANCISCO AND PENINSULA. FIVE OPERATORS ACTUALLY HAVE A ZONE 18 

BASED SYSTEM. THAT MEANS THEY HAVE A MAP OF THEIR SERVICE 19 

AREA, AND THEY ESSENTIALLY DIVIDE THAT SERVICE AREA INTO 20 

ZONES. AND THAT INFORMATION NEEDS TO BE COMMUNICATED TO 21 

PASSENGERS, USUALLY THROUGH MAPS THAT ARE AVAILABLE AT TRANSIT 22 

STOPS OR ON TRANSIT VEHICLES THEMSELVES, TO LET PASSENGERS 23 

KNOW WHICH STATIONS OR STOPS OR CITIES ARE LOCATED IN CERTAIN 24 

ZONES, AND A FARE THAT PASSENGERS ARE CHARGED IS BASED ON THE 25 
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NUMBER OF ZONES A CUSTOMER TRAVELS THROUGH. SO SOME OF OUR 1 

OPERATORS LIKE GOLDEN GATE TRANSIT, OR CALTRAIN ARE ZONE-BASED 2 

AND THE FARE THAT IS CHARGED, AGAIN, VARIES ON THE NUMBER OF 3 

ZONES YOU TRAVEL THROUGH. AND THEN FINALLY BART USES A 4 

DISTANCE BASED SYSTEM SO DEPENDING HOW FAR YOU TRAVEL ACROSS 5 

THE SYSTEM YOUR FARE IS ADJUSTED BASED ON THAT DISTANCE. I 6 

WANT TO BRIEFLY PAUSE HERE. DOES ANYONE HAVE QUESTIONS ABOUT 7 

WHAT I JUST WALKED THROUGH? IS THERE ANYTHING I CAN CLARIFY 8 

BEFORE I GO ON? OKAY. I DON'T SEE ANY HANDS. SO I'LL GO AHEAD 9 

ON. NEXT SLIDE PLEASE. SO AS I NOTED A MOMENT AGO, FARE 10 

REVENUE AT ITS CORE IS IMPORTANT FOR OPERATORS IN TERMS OF 11 

THEIR REVENUE AND WHAT THEY'RE ABLE TO HAVE -- SORRY -- THE 12 

AMOUNT OF FUNDING THEY'RE ABLE TO HAVE TO OPERATE THEIR 13 

SYSTEMS AND THE COVID-19 PANDEMIC HAS HIGHLIGHTED HOW CRITICAL 14 

FARE REVENUE IS TO SYSTEM OPERATION AND HAVING STABLE SOURCES 15 

OF FUNDING TO ENSURE THAT SERVICE IS ABLE TO BE OPERATED. WHAT 16 

WE'RE SHOWING HERE IS JUST HOW DIFFERENTLY FARE REVENUES -- 17 

HOW DIFFERENT A ROLE FARE REVENUES PLAY FOR OPERATOR IN TERMS 18 

OF THE PERCENTAGE OF THEIR OVERALL BUDGET THAT COMES FROM 19 

FARES. GRAY SECTION LOWER PORTION OF EACH OF THESE BARS FOR 20 

LARGEST SEVEN TRANSIT OPERATORS SHOWS HOW MUCH OPERATING 21 

EXPENSES COME FROM FARES. AND THE SORT OF BLUE PORTION ABOVE 22 

IS THE PART THAT SUBSIDIZED BY SOME OTHER TYPE OF FUNDING; 23 

SALES TAX REVENUE, TOLL REVENUE, SOME OTHER TYPE OF FUNDING. 24 

YOU CAN SEE THE RELIANCE ON FARES. TWO THAT STAND OUT ARE BART 25 
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ASK CALTRAIN HEAVILY RELIANT ON FARES OTHER OPERATORS SHOWN, 1 

AGAIN THESE ARE LARGE OPERATORS RELY ON FARES FOR A RELATIVELY 2 

SMALL PORTION OF THEIR REVENUE STREAMS TO SUPPORT THEIR 3 

OPERATIONS. IF YOU GO TO THE NEXT SLIDE, THIS SHOWS THE 4 

REMAINDER OF OUR TRANSIT OPERATORS, SO ALL OF OUR SMALLER 5 

SYSTEMS, SO THE SCALE HERE ON THE LEFT IS ADJUSTED GIVEN 6 

SMALLER AGENCIES AND SAN FRANCISCO FERRY SERVICE IS AN OUTLIER 7 

AMONGST THIS GROUP AND A SIGNIFICANT PORTION OF THERE 8 

OPERATING BUDGET COMES FROM PASSENGER FARES. SO THIS JUST 9 

HIGHLIGHTS THAT CHANGES TO FARE POLICY CAN HAVE VERY DIFFERENT 10 

EFFECTS ON DIFFERENT OPERATORS, DEPENDING ON HOW THEIR BUDGET 11 

RELIES ON FARES, AND WHAT THAT MEANS FOR THE SERVICE THAT THEY 12 

CAN ACTUALLY OPERATE AND DEPLOY TO THE PUBLIC. GO ON TO THE 13 

NEXT SLIDE PLEASE. SO, HOW DID WE SORT OF GET TO WHERE WE ARE 14 

NOW? OVER THE PAST SEVERAL YEARS, MTC AND THE BAY AREA'S 15 

TRANSIT OPERATORS HAVE HAD DISCUSSIONS ABOUT HOW WE CAN HAVE A 16 

MORE CUSTOMER FOCUSED TRANSIT FARE SYSTEM, AND HOW OUR FARE 17 

POLICY CAN TAKE ADVANTAGE OF THE INVESTMENT THAT THE REGION 18 

AND THE OPERATORS ARE MAKING IN THE NEXT GENERATION CLIPPER 19 

SYSTEM. WHICH, AS I MENTIONED A MOMENT AGO WILL BEGIN ITS 20 

DEPLOYMENT THIS YEAR THROUGH A CLIPPER MOBILE APP AND CONTINUE 21 

TO BE DEPLOYED FULLY OVER THE NEXT SEVERAL YEARS. WITH THAT 22 

SORT OF CONTEXT IN MIND, THERE WAS AN AGREEMENT AMONGST THE 23 

OPERATORS AND MTC TO LAUNCH A FARE COORDINATION INTEGRATION 24 

STUDY THAT WE MANAGED JOINTLY BY THE TRANSIT OPERATORS AND MTC 25 
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WITH BART AS THE LEAD FOR THE TRANSIT OPERATORS. SO THE GOALS 1 

THAT WERE ESTABLISHED FOR THIS PROJECT WERE REALLY SETTING OUT 2 

OF A VISION AND GOALS FOR WHAT THE REGIONAL FARE SYSTEM CAN DO 3 

TO HAVE AN IMPROVED USER EXPERIENCE, HOW WE CAN TRY TO GROW 4 

TRANSIT RIDERSHIP THROUGH FARE POLICIES THAT REALLY ENCOURAGE 5 

PEOPLE TO USE TRANSIT AS MUCH AS POSSIBLE. AND TO REALLY DO 6 

THAT, BASED ON ROBUST PUBLIC ENGAGEMENT, USER RESEARCH, AND 7 

OUTREACH. AND AS MIKE MENTIONED IN HIS INTRODUCTORY REMARKS WE 8 

REALLY WANTED TO UNDERSTAND THE BARRIERS TO PEOPLE USING 9 

TRANSIT, WHICH THERE ARE MANY, BUT WE WANTED TO REALLY, 10 

ESPECIALLY FOCUS ON HOW FARES IMPACT PEOPLE'S ABILITY TO USE 11 

TRANSIT AND THEIR EXPERIENCE USING THE SYSTEM, AND HOW THAT 12 

MIGHT BE INHIBITING THEM FROM USING TRANSIT IF AT ALL OR TO 13 

THE EXTENT OTHERWISE. WE WANT TO IDENTIFY OPPORTUNITIES TO 14 

INCREASE RIDERSHIP THROUGH IMPROVING THE FARE SYSTEM AS I 15 

MENTIONED AND REALLY DEVELOP AN IMPLEMENTATION PLAN AND A 16 

FUNDING PLAN FOR HOW WE CAN MOVE FORWARD SO THAT THE REGION 17 

AND OPERATORS CAN TAKE ADVANTAGE OF OPPORTUNITIES AS THEY 18 

ARISE, EITHER ON A FUNDING SIDE OR FROM TECHNICAL STANDPOINT 19 

TO IMPROVE FARE POLICY AND HELP THE CUSTOMER THROUGH A 20 

STRONGER MORE CUSTOMER FOCUSED SYSTEM. GO ON TO THE NEXT SLIDE 21 

PLEASE. SO AS MIKE MENTIONED, THIS PROJECT DOES HAVE A LOT OF 22 

DIFFERENT SORT OF ENTITIES, OR STAKEHOLDER BODIES THAT WERE 23 

CREATED AS A PART OF IT. SO, WE DO HAVE A FARE INTEGRATION 24 

TASK FORCE THAT WAS ESTABLISHED JOINTLY BY THE TRANSIT 25 
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OPERATORS AND MTC THAT IS THE OWNER AND PROJECT SPONSOR FOR 1 

THIS WORK. AND YOU CAN SEE THE LOGOS OF THE PARTICIPATING 2 

AGENCIES REPRESENTED THERE. IT'S ALL OF OUR LARGE TRANSIT 3 

OPERATORS ALONG WITH A NUMBER OF THE SMALLER OPERATORS AND 4 

THAT GROUP MEETS EVERY OTHER MONTH. NEXT MEETING WILL BE IN 5 

AUGUST. AND THEY HEAR UPDATES ON THE PROJECT, REPORTS FROM THE 6 

CONSULTANT TEAM ABOUT THE PROGRESS ON THE SCOPE OF WORK, ET 7 

CETERA. THEY HAVE THEIR FIRST REAL MEETINGS AFTER THE PROJECT 8 

LAUNCHED JUST LAST MONTH. AS WE HAVE ALSO MENTIONED, THE 9 

PROJECT MANAGERS FOR THIS WORK ARE STAFF FROM BART AND MTC. WE 10 

ARE DOING THIS IN PARTNERSHIP WITH A STAFF WORKING GROUP WHICH 11 

IS MADE UP OF STAFF FROM ALL OF THE TRANSIT OPERATORS SHOWN ON 12 

THIS SLIDE. SO THE MEMBERS OF THE FARE INTEGRATION TASK FORCE. 13 

THIS OPERATOR GROUP WAS INSTRUMENTAL IN SELECTING THE 14 

CONSULTING TEAM AND DEVELOPING SCOPE OF WORK AND PROVIDING 15 

SOUNDING BOARD FOR THE CONSULTING TEAM AND PROJECT MANAGERS ON 16 

THE WORK AND HELPING US STAY GROUNDED IN OUR SCOPE OF WORK AND 17 

UNDERSTANDING THE CHALLENGES THAT OPERATORS ARE FACING, 18 

ESPECIALLY IN THIS ENVIRONMENT RIGHT NOW, DURING COVID. SO WE 19 

DO HAVE A CONSULTANT TEAM THAT WAS PROCURED EARLIER THIS YEAR. 20 

THE CONTRACT WAS AWARDED IN MARCH OF 2020. THAT TEAM IS LED BY 21 

A CONSULTING FIRM A MENTIONED, NAMED STEER AND THAT TEAM 22 

CONSISTS OF SUBCONSULTANTS HERE IN THE BAY AREA AND AROUND THE 23 

WORLD: THIS CONSULTING TEAM IS REALLY BOTH INTERNATIONALLY 24 

BASED AND LOCALLY EXPERT SO WE WANTED TO HAVE A SORT OF A SET 25 
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OF OUTSIDE EYES WHO COULD HELP US ANALYZE THE DATA THAT WE 1 

HAVE IN THE BAY AREA, BUT ALSO THINK BIG ABOUT THE CHALLENGES 2 

AND OPPORTUNITIES THAT WE HAVE AND BRING LESSONS FROM OTHER 3 

PARTS OF THE WORLD THAT WE MIGHT BE ABLE TO LEARN FROM. SO 4 

THIS TEAM IS REALLY A GREAT GROUP THAT WE'RE EXCITED TO WORK W 5 

WE REALLY KICKED OFF THE PROJECT WITH THEM IN MAY, WHICH WAS 6 

AGAIN, SLIGHTLY DELAYED DUE TO THE PANDEMIC. THEN AS NOTED 7 

HERE, THIS GROUP TODAY, THANK YOU ALL FOR BEING PART OF THIS, 8 

THIS IS OUR REAL CORE STAKEHOLDER ADVISORY BODY, THE 9 

SUBCOMMITTEE ON FARE INTEGRATION AND COORDINATION THIS GROUP 10 

IS INTENDED TO BRING TOGETHER ADVOCATES, STAKEHOLDERS WHO ARE 11 

NOT TRANSIT OPERATORS SORT OF A BROAD GROUP OF STAKEHOLDERS 12 

AGAIN TO PROVIDE FEEDBACK TO US AND OUR HOPE IS THAT THIS BODY 13 

WILL MEET EVERY OTHER MONTH THROUGHOUT THE COURSE OF THE 14 

PROJECT SO INTO THE MIDDLE OF NEXT YEAR TO PROVIDE GUIDANCE 15 

AND INPUT TO US. AND FINALLY, I HAVE NOTED ON HERE, THAT AS A 16 

PART OF THE SORT OF AGREEMENT TO ESTABLISH THIS PROJECT, AND 17 

THE FUNDING PLAN FOR THE PROJECT THAT MTC COMMISSION APPROVED 18 

IN OCTOBER OF LAST YEAR THERE IS ALSO TO BE A POLICY MAKER 19 

FORUM ON INTEGRATION WHICH WOULD BRING TOGETHER TO GOVERNING 20 

BOARD MEMBERS ON THE INTEGRATION TASK FORCE AS WELL AS MTC ON 21 

THREE PROJECTS TO HEAR UPDATES ON THE STATUS OF THE WORK. 22 

WE'RE FIGURING OUT NOW HOW WE CAN ADJUST THAT PERHAPS TO 23 

RECOGNIZE THE BROADER CHALLENGES THAT THE OPERATORS ARE FACING 24 

BECAUSE OF THE PANDEMIC, SO WE HAVEN'T CONVENED THAT GROUP 25 
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YET, BUT THIS IS ANOTHER PART OF THIS PROJECT. WE CAN GO AHEAD 1 

AND ACTUALLY SKIP TO SLIDE 12, JUST IN THE INTEREST OF TIME 2 

AND WANTING TO MAKE SURE EVERYONE CAN TALK AS MUCH AS YOU HAVE 3 

QUESTIONS AND IDEAS HERE. SO AS I NOTED, THE PROJECT IS AIMING 4 

FOR CONCLUDING IN THE MIDDLE OF 2021, AND YOU CAN SEE ON THIS 5 

SLIDE, THE SORT OF PROPOSED TIMELINE AND WHAT WE'RE THINKING 6 

RIGHT NOW AS WELL AS SOME OF THE RISKS THAT WE FACE, AND THIS 7 

IS AGAIN SOMETHING WE REALLY WANT TO GET YOUR INPUT ON TODAY 8 

WHICH IS THE SUBJECT OF USER RESEARCH. ABOUT A THIRD OF OUR 9 

PROJECT BUDGET WAS INTENDED TO BE SPENT ON USER RESEARCH, 10 

REALLY GETTING ON THE GROUND, AND TALKING TO TRANSIT USERS, 11 

TALKING TO NON-USERS OF THE SYSTEM, AND UNDERSTANDING HOW FARE 12 

POLICY IMPACTS THEM, IS HOW FARE POLICY MAYBE INHIBITS THEM 13 

FROM USING TRANSIT AS MUCH AS THEY WOULD LIKE. SO WE ARE -- WE 14 

CERTAINLY ARE TO FACE RISK IN THIS CATEGORY SINCE WE CAN'T BE 15 

ON THE GROUND TALKING TO PEOPLE FACE-TO-FACE OR IN GROUPS LIKE 16 

WE DID BEFORE THE PANDEMIC THAT'S A LAYER THAT'S GOING TO BE 17 

DISPERSED THROUGHOUT THE PROJECT THIS IS AN AREA WE SEEK YOUR 18 

FEEDBACK ON TODAY. OTHER AREAS I WON'T WALK YOU THROUGH IT BUT 19 

YOU CAN SEE THE DIFFERENT ELEMENTS AS WE PROGRESS TO THE END 20 

OF THE PROJECT WHERE WE WOULD REALLY HAVE SPECIFIC STRATEGIES 21 

AND A VISION FOR WHAT FARE POLICY IN THE REGION COULD EVOLVE 22 

TO, AND WE WOULD BE DOING ANALYSIS, MODELING WORK, FINANCIAL 23 

PLANNING, LOOKING AT HOW IMPLEMENTATION OF THAT VISION WOULD 24 

IMPACT RIDERSHIP, THE FINANCIAL POSITION OF OPERATORS, ET 25 
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CETERA. NOW, I THINK THIS IS PROBABLY OBVIOUS TO ALL OF YOU, 1 

BUT OUR SCOPE OF WORK WAS DEVELOPED BEFORE THE PANDEMIC, AND 2 

THE SITUATION HAS CHANGED DRAMATICALLY FROM A RIDERSHIP 3 

STANDPOINT, FROM A FINANCIAL STANDPOINT FOR OPERATORS, SO SOME 4 

OF THE SORT OF FRAMING THAT WE WOULD HAVE DONE HAD COVID NOT 5 

HAPPENED WOULD PROBABLY BE A BIT DIFFERENT NOW BECAUSE OF THE 6 

PANDEMIC AND THAT'S SOMETHING WE'RE LOOKING FORWARD TO 7 

DISCUSSING WITH THIS GROUP OVER THE COMING YEAR TO FIGURE OUT 8 

HOW TO BEST PRESENT THE UNLESS AND GROUND IT IN THE REALITY 9 

WE'RE IN TODAY, NOT NECESSARILY EXCLUSIVELY IN A PRE COVID 10 

REALITY. SO I'LL GO ON TO THE NEXT SLIDE AND THIS WILL BE THE 11 

LAST SLIDE THEY WANT TO WALK US THROUGH AND I'LL TURN IT OVER 12 

TO MIKE. COVID-19 REALLY HAS PRESENTED AN UNPRECEDENTED SET OF 13 

CHALLENGES FOR THE PASSENGERS AND PUBLIC AT LARGE WHO ARE 14 

TRYING TO USE TRANSIT TO ACCESS THEIR JOBS TO ACCESS HEALTH 15 

CARE TO ACCESS BASIC NECESSITIES OF LIFE. IT'S CREATED 16 

INCREDIBLE CHALLENGES FOR TRANSIT STAFF WHO ARE REALLY ON THE 17 

FRONT LINES EVERY SINGLE DAY, AND IN SOME INSTANCES ARE REALLY 18 

RISKING THEIR LIVES TO DELIVER SERVICE AND ENSURE THE PUBLIC 19 

STILL HAS MOBILITY AND FOR THE AGENCIES THEMSELVES ESPECIALLY 20 

FOR OPERATORS THAT ARE VERY DEPENDENT ON FARES AS WE TALKED 21 

ABOUT A MOMENT AGO, IF HALF OF YOUR BUDGET HAS BASICALLY 22 

DISAPPEARED IT CREATES A SERIOUS FINANCIAL RISK FOR YOUR 23 

AGENCY AND YOUR ABILITY TO PROVIDE SERVICE IN THE LONG-TERM. 24 

CARES ACT AND THE FEDERAL FUNDING THAT WAS INCLUDED WITH IT, 25 
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FOR TRANSIT OPERATORS, WAS A TREMENDOUSLY IMPORTANT LIFELINE 1 

TO MAKE SURE THAT THE AGENCIES CAN CONTINUE TO OPERATE, BUT IT 2 

ONLY LASTS SO LONG AND SINCE WE HAVE NO IDEA WHERE THE 3 

PANDEMIC WILL TAKE US OVER THE COMING MONTHS, IT IS A 4 

SIGNIFICANT CHALLENGE FOR OUR SYSTEMS. AND I WANT TO NOTE, 5 

SINCE THIS GROUP TODAY, WE'RE REALLY -- YOU ARE STAKEHOLDERS 6 

AND THE PUBLIC, WE RECOGNIZE THAT FROM A USER PERSPECTIVE, SO 7 

MUCH HAS CHANGED WITH TRANSIT SINCE MARCH. AND THE PUBLIC IS 8 

FACING DIFFERENT SCHEDULES. YOU COULD HAVE BEEN VERY USED TO A 9 

SPECIFIC SCHEDULE FOR YOUR SERVICE OR SERVICE US THAT USE 10 

REGULARLY THAT ARE COMPLETELY THROWN OUT THE WINDOW NOW, AND 11 

YOUR SERVICE MIGHT COME EVERY HOUR INSTEAD OF EVERY 20 MINUTES 12 

LIKE IT USED TO. THAT THERE ARE TREMENDOUS CONCERNS ABOUT 13 

SAFETY, AND HOW -- WHAT TYPE OF EXPERIENCE YOU WILL FACE USING 14 

TRANSIT. I THINK THE OPERATORS ARE DOING A LOT ON THIS TOPIC, 15 

BUT IT'S STILL SOMETHING THAT PASSENGER ARE VERY CONCERNED 16 

ABOUT. AND PEOPLE USE TRANSIT TO ACCESS JOBS. THAT'S AN 17 

IMPORTANT PART OF OUR TRANSIT SYSTEM, AND SINCE SO MANY PEOPLE 18 

IN OUR REGION AND AROUND THE COUNTRY HAVE FACED JOB LOSSES OR 19 

FURLOUGHS OVER THE LAST FEW MONTHS IT CHANGES THE FINANCIAL 20 

SITUATION OF INDIVIDUALS AND THEIR NEED AND ABILITY TO USE 21 

TRANSIT. YOU MIGHT HAVE USED TRANSIT REGULARLY AT A CERTAIN 22 

TIME OF DAY BEFORE THE PANDEMIC AND NOW PERHAPS YOU USE IT AT 23 

A DIFFERENT TIME OF DAY AND FIND THE SERVICES VERY DIFFERENT. 24 

AND THEN IT'S IMPORTANT TO NOTE AS WELL THAT TRANSIT PROVIDES 25 
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AN IMPORTANT ACCESS ROUTE FOR MEMBERS OF OUR COMMUNITY TO 1 

EDUCATION. AND WITH SCHOOLS, COMMUNITY COLLEGES, UNIVERSITIES, 2 

PRIMARILY, OPERATING ON A DISTANCE LEARNING BASIS RIGHT NOW, 3 

THE TYPE OF SERVICE THAT PEOPLE ARE USING TO ACCESS THOSE 4 

EDUCATIONAL INSTITUTIONS MIGHT NOT BE NECESSARY ANYMORE, OR 5 

MIGHT HAVE CHANGED SIGNIFICANTLY, AND THAT HAS A MAJOR IMPACT 6 

AS WELL ON BOTH THE PUBLIC AND ON OUR OPERATORS. SO IF ANYONE 7 

HAS ANY QUESTIONS ABOUT WHAT WE HAVE JUST WALKED THROUGH, AS 8 

SORT OF BACKGROUND, I'M HAPPY TO TAKE THAT NOW. AND OTHERWISE 9 

I'LL TURN IT OVER TO MIKE WHO WILL START TO GET INTO A LITTLE 10 

BIT MORE OF WHAT WE WANT TO DISCUSS WITH YOU WHICH IS PROBLEM 11 

STATEMENT, USER RESEARCH AND HOW WE APPROACH THAT.  12 

 13 

MICHAEL EISEMAN: BUT BILL. I'LL PUT THE QUESTION TO ADINA AS 14 

OUR CHAIR HERE. DO YOU WANT TO BREAK HERE AND HAVE SOME 15 

DISCUSSION ON THIS GENERAL ITEM? OR DO YOU WANT TO MOVE INTO 16 

THE PROBLEM STATEMENT SPECIFICALLY FIRST?  17 

 18 

ADINA LEVIN: LET'S SEE. OUT OF THE PANELISTS, DOES ANYBODY 19 

WANT TO RAISE A HAND IF THERE IS A QUESTION THAT YOU HAVE 20 

ABOUT THE MATERIAL THAT HAS BEEN PRESENTED TO DATE? IF SO 21 

PLEASE RAISE YOUR HAND, IF NOT WE'LL MOVE ON.  22 

 23 

WENDI KALLINS: ADINA I AM HERE NOW.  24 

 25 
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ADINA LEVIN, CHAIR: WELCOME WENDI. FOR PERSONS WHO HAVE HEARD 1 

THE PRESENTATION, ANY HANDS WITH QUESTIONS? ALL RIGHT. I SEE 2 

THAT TISHA HAS A QUESTION.  3 

 4 

SPEAKER: THANK YOU. MINE IS A QUESTION. IN ORDER TO ENTER HOW 5 

WE CAN BETTER ACCESS GROUP DEMOGRAPHICS AND UNDERSTANDING 6 

THEIR BARRIERS, A QUESTION TO ME IS, DO WE HAVE DEMOGRAPHICS 7 

OF RIDERSHIP? I THINK THAT'S IMPORTANT SO WE CAN KEEP EQUITY 8 

VISIBLE, AND ALSO TO BETTER UNDERSTAND WHERE WE NEED TO FOCUS 9 

GROWTH STRATEGIES AND SO THAT WE CAN BOTH BE EFFECTIVE AND 10 

STRATEGIC IN REACHING OUT TO THEM TO UNDERSTAND THOSE BARRIERS 11 

FOR THEM?  12 

 13 

WILLIAM BACON: THANK YOU FOR THAT QUESTION IT'S AN IMPORTANT 14 

QUESTION ABOUT WHAT TYPE OF DATA WE HAVE AND WHO IS USING THE 15 

SYSTEM. WE HAVE AT A REGIONAL LEVEL A FAIRLY ROBUST DATA SET 16 

THIS COMES FROM MTC REGIONAL TRAVEL SURVEY THAT WE DO IN 17 

PARTNERSHIP WITH ALL OF THE OPERATORS. THAT COLLECTS 18 

INFORMATION, ESPECIALLY ABOUT DEMOGRAPHIC CHARACTERISTIC LIKE 19 

HOUSEHOLD INCOME, ACCESS TO VEHICLES WITHIN A HOUSEHOLD THINGS 20 

LIKE THAT. WE HAVE LESS SPECIFIC DETAIL ABOUT THE -- IN THE 21 

REGIONAL DATA SET -- ABOUT ETHNICITY OF PASSENGERS, BUT 22 

TRANSIT OPERATORS THEMSELVES HAVE MUCH MORE ROBUST DATA IN 23 

THEIR OWN DATA SETS ABOUT THE DEMOGRAPHICS OF THE USERS OF 24 

THEIR SYSTEM AND THEY HAVE TO COLLECT THAT INFORMATION AS A 25 
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PART OF THEIR FEDERAL TITLE SIX ANALYSIS WHEN THEY DO CHANGES 1 

TO FARE POLICY OR MANY OTHER ASPECTS OF THEIR SERVICE. SO ONE 2 

OF THE THINGS WE NEED TO DO IN THE SORT OF FIRST PHASE OF OUR 3 

PROJECT IS COLLECT ALL OF THE RELEVANT DATA THAT'S NECESSARY 4 

TO DO THE ANALYSIS AND SORT OF THIS DEMOGRAPHIC DATA IS 5 

IMPORTANT PART OF THAT. ONE OTHER THING I'LL ASK MAYBE A 6 

QUESTION TO THE SUBCOMMITTEE IS, WE HAVE A LOT OF DATA PRE 7 

COVID, BUT THE RIDERSHIP OF OUR SYSTEM AND THE MAKE UP OF WHO 8 

IS USING OUR SYSTEM HAS CHANGED A LOT. I THINK ANECDOTALLY WE 9 

KNOW MOST OF THE PEOPLE USING TRANSIT TODAY ARE DEPENDENT ON 10 

THE SERVICE AND DEPENDENT ON THE SYSTEMS BUT WE DON'T HAVE 11 

GOOD DATA ABOUT WHO THOSE INDIVIDUALS ARE AND MORE ROBUST 12 

INFORMATION ABOUT WHO IS USING THE SYSTEM TODAY. SO THAT'S AN 13 

AREA WHERE WE GOING TO CONTINUE AS STAFF INVESTIGATING TO SEE 14 

WHAT INFORMATION WE CAN COLLECT, BUT AGAIN AS SOME COMMUNITY 15 

MEMBERS, IF YOU HAVE THOUGHTS OR IDEAS ABOUT WAYS TO THINK 16 

ABOUT THAT QUESTION, OR TO ACCESS DATA, ARE WE'RE ALL EARS. SO 17 

THANK YOU FOR THAT QUESTION.  18 

 19 

ADINA LEVIN: ALL RIGHT. SO I SEE THAT RICH HEDGES HAS A 20 

QUESTION.  21 

 22 

RICHARD HEDGES: YEAH, THANK YOU, CAN EVERYONE HERE ME? I HAVE 23 

HAD A LITTLE PROBLEM WITH CAMERA AND SOUND. THIS IS AN OVERALL 24 

QUESTION WITHOUT WAITING TO FIND OUT IF WE CAN DO IT I AM 25 
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INTERESTED AND I BELIEVE MANY MEMBERS OF OUR GROUP ARE 1 

INTERESTED IN A REGIONAL FARE POLICY WHERE ONE FARE FITS ALL 2 

KNOWING PROBLEMS WE HAD IN THE GRANDFATHER OF CLIPPER, IS IT 3 

POSSIBLE, GIVEN ALL OF THE COMPLEXITIES WITH THE VARIOUS FARE 4 

SYSTEMS, TO HAVE A REGIONAL FARE? I WANT TO KNOW THAT BEFORE 5 

WE GET OFF ON DEALING WITH IT. THANK YOU.  6 

 7 

WILLIAM BACON: CAN I CLARIFY, RICH, IS YOUR QUESTION SAYING, 8 

IS IT TECHNICALLY POSSIBLE THAT WE COULD HAVE A SINGLE FARE 9 

POLICY?  10 

 11 

RICHARD HEDGES: TECHNICALLY AND POLITICALLY, POSSIBLY.  12 

 13 

WILLIAM BACON: I'LL SPEAK TO THE TECHNICAL SIDE AT LEAST.  14 

 15 

RICHARD HEDGES: GOOD IDEA.  16 

 17 

WILLIAM BACON: THE NEXT GENERATION CLIPPER SYSTEM WHICH FOR 18 

THOSE OF YOU WHO AREN'T FAMILIAR, THE REGION AND OPERATORS ARE 19 

INVESTING IN REPLACING THE CURRENT CLIPPER SYSTEM RIGHT NOW 20 

AND THE TECHNOLOGY IS BEING DEVELOPED AND, AGAIN WILL BEGIN TO 21 

BE DEPLOYED LATER THIS YEAR, THAT SYSTEM WILL TECHNOLOGICALLY 22 

MAKE IT EASIER TO CHANGE FARE POLICY AND MUCH CHEAPER TO 23 

IMPLEMENT CHANGES TO THE FARE POLICY WHICH RIGHT NOW IS ONE OF 24 

THE BIG BARRIERS BECAUSE OF THE 20,000 BUSINESS RULES I 25 
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MENTIONED. OUR CURRENT TECHNOLOGY USES INFRASTRUCTURE, 1 

BASICALLY, FROM MORE THAN 20 YEARS AGO. IT'S VERY OLD, SO THIS 2 

WILL REALLY BRING THE FARE PAYMENT TECHNOLOGY INTO THE 21st 3 

CENTURY AND ALLOW THE FLEXIBILITY PEOPLE WANT NOW. IN TERMS OF 4 

LOGISTICS OF FARE POLICY CHANGE RIGHT NOW THE TRANSIT 5 

OPERATORS CONTROL THEIR FARE POLICY SO THIS IS LOOKING AT 6 

SETTING OUT IDEAS AND A VISION FOR WHAT THE REGION COULD 7 

COLLECTIVELY ACHIEVE AND QUESTIONS ABOUT GOVERNANCE, OR 8 

CHANGES TO THAT ARE REALLY SORT OF BROADER TOPICS THAT ARE 9 

ADDRESSED A LITTLE BIT OUTSIDE THE STUDY, AND I DON'T KNOW 10 

MIKE IF YOU HAVE ANYTHING TO ADD TO THAT?  11 

 12 

MICHAEL EISEMAN: ONLY TO SAY, I THINK WE HAVE -- THERE IS A 13 

BROAD RANGE OF POTENTIAL OF PROPOSALS WE COULD HAVE, AND I 14 

THINK WE HAVE SET OUT TO TRY TO COVER THAT RANGE. SO, YOU 15 

KNOW, THIS PROJECT COULD PROPOSE RELATIVELY SMALL FIXES, IT 16 

COULD PROPOSE QUITE A LARGE CHANGE IN THE STRUCTURE OF FARES 17 

IN THE REGION, AND THAT -- AND THOSE BIG CHANGES COULD INCLUDE 18 

CONSIDERATION OF ISSUES UP TO AND INCLUDING GOVERNANCE. BUT, 19 

THERE IS A LOT OF WORK TO DO TO UNDERSTAND IMPLICATIONS AND 20 

CHALLENGES IN THE PROCESS. I WOULD SAY WE'RE NOT RULING 21 

ANYTHING OUT AT THE START OF THE STUDY.  22 

 23 

RICHARD HEDGES: IF I CAN JUST ONE STATEMENT, JUST DID A QUICK 24 

STUDY ON -- IT'S ABOUT $13.25 1 WAY, SO YOU'RE LOOKING AT AN 25 
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ADULT WITHOUT THEIR DISCOUNTS ROUND TRIP FROM MTC ABOUT 26 1 

BUCKS. THAT'S PROHIBITIVE FOR MANY INDIVIDUALS TO USE TRANSIT. 2 

THAT'S WHY I'M SO INTERESTED IN A REGIONAL ONE-TIME PAYMENT 3 

FARE POLICY.  4 

 5 

ADINA LEVIN: THANK YOU RICH. RANDI KINMAN HAS HAD HER HAND 6 

RAISED.  7 

 8 

RANDI KINMAN: THANK YOU. JUST A REQUEST TO STAFF, SINCE WE'RE 9 

DISCUSSING, SINCE EQUITY QUESTION CAME UP, CAN YOU PLEASE 10 

ROUTE OUT EITHER SEPARATELY OR IN OUR NEXT PACKET, THE MAPPING 11 

THAT WE HAVE FOR COMMUNITIES OF CONCERN? I THINK THAT WILL 12 

HELP PEOPLE WHO ARE NEW TO THE REGIONAL DISCUSSION SEE WHERE 13 

OUR COMMUNITIES OF POVERTY AND COLOR ACTUALLY ARE, AND IT'S A 14 

BASELINE FOR US TO AT LEAST START THAT CONVERSATION AS WE WAIT 15 

FOR NEW DATA. THANK YOU.  16 

 17 

WILLIAM BACON: WE'LL DEFINITELY BE ABLE TO DO THAT. THANKS 18 

RANDI.  19 

 20 

ADINA LEVIN, CHAIR: GREAT. MOVING ON TO WENDI KALLINS WHO HAS 21 

HAD A HAND UP.  22 

 23 

WENDI KALLINS: YES. THIS IS A FOLLOW UP TO RICH'S QUESTION AND 24 

COMMENTS. -- IN LOOKING AT THE CHART, IT'S REALLY OBVIOUS THAT 25 
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THE RAIL LINES, YOU KNOW, BART, AND CALTRAIN, IN PARTICULAR, 1 

THEY CHARGE MORE FOR THE SERVICE, AND THEY ALSO HAVE A MUCH 2 

HIGHER PERCENTAGE OF THEIR INCOME COMING FROM FARES, HOW ARE 3 

WE GOING TO BE WEIGHING THAT AS WE LOOK AT THE LARGER SYSTEM 4 

AND FINDING SOME KIND OF FARE INTEGRATION WHEN YOU HAVE THOSE 5 

KIND OF DISPARITIES GOING ON?  6 

 7 

MICHAEL EISEMAN: MAYBE JUST ON THAT I SHOULD SAY, SPEAKING AS 8 

BOTH A PARTICIPANT AND BART STAFF PERSON, YES THAT IS A BIG 9 

CHALLENGE AND SOMETHING THIS STUDY IS GOING TO HAVE TO -- 10 

ESPECIALLY WHEN WE START THINKING ABOUT BIG MOVES ON FARES 11 

IT'S GOING TO BE A COMPLEX CHALLENGE WE'RE GOING TO HAVE TO 12 

THINK CAREFULLY ABOUT.  13 

 14 

ADINA LEVIN, CHAIR: I SEE IAN GRIFFITHS HAS A HAND RAISED AS 15 

WELL.  16 

 17 

IAN GRIFFITHS: ON THE QUESTION THAT RICHARD POSED, I MEAN, I 18 

CERTAINLY BELIEVE THAT THE ROLE OF THIS STAKEHOLDER GROUP 19 

SHOULD NOT BE CONSTRAINED BY WHAT THE EXISTING STRUCTURES OR 20 

FUNDING SOURCES THAT WE HAVE. I THINK OUR ROLE, AND THE ROLE 21 

OF THIS STUDY AS A WHOLE IS TO LEAD WITH WHAT IS RIGHT FOR 22 

USERS, WHAT IS RIGHT FOR THE PUBLIC, WHAT WILL -- LIKE, 23 

FOCUSING ON, I AGREE WITH THE GOALS THAT ARE STATED AT THE 24 

OUTSET FOR THE STUDY, AND IF WE KEEP OURSELVES FOCUSED ON 25 
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DEVELOPING FARE SYSTEMS THAT ACHIEVE THOSE GOALS, WE MAY FIND 1 

THAT WE DON'T HAVE THE RIGHT GOVERNANCE IN PLACE. WE NEED TO 2 

LOOK AT OTHER FARE REVENUE SOURCES. BUT IF WE'RE NOT EVER 3 

GOING TO EXPLORE THOSE THINGS OR BUILD A CASE FOR THOSE THINGS 4 

IF WE DON'T HAVE A STUDY THAT DOCUMENT WHERE IS THEY'RE 5 

NEEDED. AND THERE IS A NUMBER OF THINGS GOING ON RIGHT NOW, 6 

THROUGH THE BLUE RIBBON TASK FORCE, AND OTHER STATE AND 7 

REGIONAL LEADERS THAT SUGGEST THAT THERE IS THAT POSSIBILITY. 8 

SO THIS STUDY, I SEE THIS STUDY AS PLAYING AN IMPORTANT ROLE 9 

IN, AGAIN, LEADING WITH WHAT'S RIGHT FOR USERS. SO I'M HAPPY 10 

TO HEAR THAT WE'RE NOT CONSTRAINING OURSELVES BY WHAT'S 11 

CURRENTLY POSSIBLE, AND I WOULD JUST ENCOURAGE EVERYONE IN 12 

THIS GROUP TO NOT SORT OF ARTIFICIALLY TAKE THINGS OFF THE 13 

TABLE BECAUSE IT DOESN'T SEEM POSSIBLE RIGHT NOW. I THINK IT'S 14 

OUR ROLE TO LEAD WITH WHAT WE THINK SHOULD BE THE SYSTEM.  15 

 16 

ADINA LEVIN, CHAIR: OKAY. GREAT. SO THAT SEEMS LIKE THE END OF 17 

THE HANDS. I HAVE ONE SHORT QUESTION TO ASK -- MIGHT NOT BE 18 

SHORT TO ANSWER, AND THEN WE CAN MOVE ON TO THE NEXT PIECE OF 19 

THE PRESENTATION. MY QUESTION WAS, WITH THOSE 20,000 BUSINESS 20 

RULES WHERE PRESUMABLY THAT MAKES IT FLOW AND COSTLY BE ABLE 21 

TO CHANGE TO BE ABLE TO IMPLEMENT ANY CHANGES TO THAT PRETTY 22 

COMPLICATED SYSTEM, HAS THE CLIPPER TEAM ASSESSED THAT IF 23 

THOSE NUMBER OF RULES WERE SIMPLIFIED, HOW MUCH COST SAVINGS 24 

THERE MIGHT BE AND HOW MUCH TIME SAVINGS THERE MIGHT BE TO THE 25 
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FARE SYSTEM? BECAUSE, YOU KNOW, WE HAVE BEEN TALKING ABOUT 1 

SOME CHANGES THAT MIGHT COST MONEY, MIGHT THERE BE ANY SAVINGS 2 

IN THINGS WE'RE TALKING ABOUT? IS THAT A QUESTION WITH A KNOWN 3 

ANSWER?  4 

 5 

WILLIAM BACON: THIS IS BILL AGAIN, COPROJECT MANAGER. I CAN'T 6 

SPEAK SPECIFICALLY ADINA TO THE DOLLAR COST CHANGES FROM A 7 

REDUCTION IN BUSINESS RULES. I CAN SPEAK GENERALLY THAT SORT 8 

OF WHAT YOU WERE SORT OF ASKING THERE, DOES THE COST GO DOWN 9 

AS THE BUSINESS RULES DECREASE. AND THERE'S A CORRELATION 10 

THERE IF WE HAVE NEW BUSINESS RULES THE COST OF IMPLEMENTING 11 

INDIVIDUAL FARE POLICY CHANGES CAN BE LOWER BECAUSE IT NEEDS 12 

TO BE TESTED AGAINST FEWER COMBINATIONS OF OTHER BUSINESS 13 

RULES. COMPLEXITY IN AND OF ITSELF IS NOT ALWAYS A BAD THING 14 

IN TERMS OF HOW A FARE POLICY MIGHT WORK ON THE BACK END, BUT 15 

IT DOES HAVE IMPLEMENTATION COSTS FROM A TECHNICAL STANDPOINT, 16 

BUT IT MIGHT NOT ACTUALLY BE BAD FROM A USER PERSPECTIVE. 17 

THERE CAN BE COMPLICATED TECHNOLOGY SOLUTIONS THAT IMPLEMENT 18 

SOMETHING VERY GOOD FOR THE PUBLIC. SO I DON'T THINK WE SHOULD 19 

BE CON STRAND BY THINKING BUSINESS RULES ARE JUST THAT. BUT IN 20 

OUR CURRENT TECHNOLOGY IT IS COSTLY TO MAKE CHANGES AS A 21 

RESULT OF THOSE BUSINESS RULES IN OUR NEW NEXT GENERATION 22 

CLIPPER SYSTEM BECAUSE IT'S NOT TECHNOLOGY FROM 1998 IT WILL 23 

BE EASIER TO USE AND EASIER TO MAKE CHANGES FROM A TECHNOLOGY 24 

STANDPOINT. AT OUR NEXT COMMITTEE MEETING WE CAN HAVE ONE OF 25 
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OUR STAFF CLIPPER MEMBERS TO BE PRESENT TO ANSWER QUESTIONS 1 

ABOUT THE BALANCE OF COST REDUCTION THAT WE MIGHT BE ABLE TO 2 

ACHIEVE.  3 

 4 

ADINA LEVIN, CHAIR: OKAY. SO I HAVE A BUNCH OF QUESTIONS ABOUT 5 

EQUITY THAT PROBABLY RELATE TO USER RESEARCH THEY WILL ASK ALL 6 

THE WAY AT THE END. I SEE THAT BRIAN STANKE HAS HIS HAND 7 

RAISED. SO GO AHEAD BRIAN, BEFORE WE MOVE ON TO THE NEXT PART 8 

OF THE PRESENTATION.  9 

 10 

BRIAN STANKE: QUICKLY ON FEASIBILITY, COST, TECHNOLOGY, I 11 

THINK SOMETHING THAT WAS POINTED OUT IN THE PRESENTATION SO 12 

FAR, AND THAT HASN'T CHANGED WITH COVID, IS WHEN WE HAVE 30 13 

SOMETHING AGENCIES WITH MULTIPLE DIFFERENT DEFINITIONS OF HOW 14 

OLD A YOUTH IS, HOW MUCH A DISCOUNT IS, THERE IS NO TECHNOLOGY 15 

NEEDED TO ALIGN THOSE POLICIES. IT CAN BE DONE BY ALL 30 16 

AGENCIES AGREEING THIS IS WHAT A YOUTH IS, THIS IS WHAT THE 17 

DISCOUNT IS, AND WHAT CAN BE DONE WITHIN STATE LAW. THERE IS A 18 

DECISION TO DO IT, BUT, AND THERE IS NO TECHNOLOGICAL BARRIER 19 

FOR ALIGNING A LOT OF THESE POLICIES AND RULES. SO WE HAVE TO 20 

KEEP THAT IN MIND, AND THERE COULD BE SIGNIFICANT SAVINGS AND 21 

PEOPLE, YOU KNOW, THAT THE PUBLIC UNDERSTANDING WHAT THE RULES 22 

ARE. WE HAVE 15 DIFFERENT YOUTH FARES AND NO ONE CAN REMEMBER 23 

THAT. AND THAT'S SOMETHING THAT'S NOT AFFECTED BY WHATEVER 24 

COVID OR WHATEVER THE FUTURE BRINGS.  25 
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 1 

WILLIAM BACON: THOSE ARE REALLY IMPORTANT POINTS. ONE THING I 2 

WOULD NOTE IS THERE HAS BEEN SOME PROGRESS OVER THE LAST FEW 3 

YEARS IN THE REGION, AND THE OPERATORS ACTUALLY DO, NOW, AGREE 4 

ON THE AGES OF YOUTH AND SENIORS, WHICH WAS NOT THE CASE IN 5 

THE PAST. SO THERE IS AGREEMENT THAT, YOU KNOW, A SENIOR 6 

STARTS AT AGE 65, WHICH HAD NOT ALWAYS BEEN THE CASE. BUT OF 7 

THE ACTUAL DISCOUNTS THAT ARE OFFERED ARE WHAT I WAS 8 

HIGHLIGHTING EARLIER IN THE PRESENTATION. SO THERE IS VERY 9 

DIFFERENT DISCOUNT RATES THAT ARE OFFERED DEPENDING ON WHICH 10 

SYSTEM YOU'RE USING IF YOU ARE A YOUTH OR A SENIOR.  11 

 12 

CLERK OF THE BOARD: YOU HAVE TO UNMUTE YOURSELF.  13 

 14 

ADINA LEVIN, CHAIR: ALL RIGHT. I THINK WE ARE SEEING -- I'M 15 

NOT SEEING HANDS FROM ANYBODY THAT HASN'T SPOKEN.  16 

 17 

CLERK OF THE BOARD: TISHA HAS HER HAND UP.  18 

 19 

ADINA LEVIN, CHAIR: TISHA DO YOU WANT TO SPEAK AGAIN OR DO YOU 20 

HAVE SOMETHING FOR THE END?  21 

 22 

SPEAKER: I CAN SAVE IT FOR THE END THAT'S FINE.  23 

 24 
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ADINA LEVIN, CHAIR: IN THE INTEREST OF HEARING FROM STAFF, 1 

LET'S HEAR THE NEXT PIECE OF THE PRESENTATION AND THEN ASK 2 

MORE QUESTIONS AND MAKE MORE COMMENTS THEN. SO HANDING THIS 3 

BACK OVER TO STAFF.  4 

 5 

MICHAEL EISEMAN: OKAY. LET'S SEE. CAN WE DISPLAY THE 6 

POWERPOINT DECK HERE STARTING ON SLIDE 15? DO FOLKS SEE THE 7 

POWERPOINT DECK OR NO? NEXT TOPIC IS THE PROBLEM STATEMENT. 8 

IT'S A STEP IN THE STUDY, IT'S TO CREATE A PROBLEM STATEMENT, 9 

AND YOU KNOW, IF YOU THINK OF THE BACKGROUND MATERIAL THAT 10 

BILL JUST RAN THROUGH, THIS IS A COMPLEX ISSUE THAT HAS A LOT 11 

OF DIFFERENT FACETS SO THE PROBLEM STATEMENTS TRIES TO PUT ON 12 

PAPER EXACTLY WHAT ARE WE DOING HERE, WHAT ARE THE ISSUES 13 

WE'RE TRYING TO ADDRESS IN A CONCISE WAY. AND WE'RE FRAMING 14 

THIS AS A HYPOTHESIS TO TEST AND A STATEMENT THAT WILL BE 15 

REFINED AS WE MUTUAL THROUGH THE STUDY AND LEARN THINGS -- 16 

THAT'S THE BASIC IDEA HERE AND THIS HAS FOUR PARTS HERE THE 17 

MATERIAL THAT WE GOT FOR YOU, IN THE PROBLEM STATEMENT, THE 18 

FIRST PART IS A KIND OF STATEMENT OF WHERE WE THINK FARES FITS 19 

IN THE CONTEXT OF THE BROADER SET OF ISSUES AND CHALLENGES FOR 20 

REGIONAL TRANSIT, TRANSPORTATION MOBILITY. SO THAT'S AN 21 

IMPORTANT CONTEXT STATEMENT, AND THEN THERE IS A CONCISE SORT 22 

OF THE CORE OF THE PROBLEM STATEMENT ITSELF, IS SHOWN IN PART 23 

TWO, AND THEN SOME MORE DETAIL ABOUT HOW WE MIGHT SORT OF 24 

PROCEED IN STUDYING EACH ELEMENT OF THE PROJECT STATEMENT -- 25 
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OF THE PROBLEM STATEMENT. SO MAYBE IF WE COULD MOVE TO SLIDE -1 

- THE NEXT SLIDE, PLEASE. SO THE PROBLEM STATEMENT PART ONE 2 

THIS IS THE CONTEXT THEY JUST MENTIONED. SO, IN THE FIRST TWO 3 

PARAGRAPHS HERE KIND OF SPEAK TO THE BACKGROUND THAT BILL JUST 4 

COVERED SO MAYBE I'LL FOCUS ON THE SECOND TWO PARAGRAPHS. SO 5 

ONE IS, WE TRY TO CAPTURE -- YOU KNOW, IF WE'RE THINKING ABOUT 6 

HOW FARES AFFECT MOBILITY FARES SIT IN CONTEXT OF IMPORTANT 7 

FACTORS SO WE TRY TO LAY OUT THOSE. TRANSIT SERVICE 8 

RELIABILITY, FREQUENCY, COVERAGE, CONNECTIVITY, LAND USE AND 9 

DEVELOPMENT PATTERNS, THE PRICE OF TRANSIT RELATIVE TO OTHER 10 

OPTIONS AND IS A FARE ISSUE. THOSE ARE IMPORTANT FACTORS IN 11 

PEOPLE'S DECISION MAKING AROUND MOBILITY AND THE CONVENIENCE 12 

OF THE SYSTEM MAY BE IMPORTANT FOR TRAVELLERS. THIS IS WHY 13 

THIS IS IMPORTANT. AND BUT WE DO WANT TO IDENTIFY THAT BAY 14 

AREA TRANSIT RIDERS FACE CHALLENGES ACROSS ALL OF THOSE AREAS 15 

AND THIS STUDY SITS IN THAT CONTEXT AND LASTLY, THE AUDIENCE 16 

THAT COVID-19 HAS IMPACTED ALL AREAS OF THE REGION, TRANSIT, 17 

MORE THAN MOST, AND THE STUDY WILL HAVE TO PROCEED IN THAT 18 

CONTEXT. SO NEXT SLIDE PLEASE. SO THIS IS SORT OF THE CORE OF 19 

THE PROBLEM STATEMENT. AND, AGAIN, WE ARE FRAMING THIS AS A 20 

HYPOTHESIS TO TEST, AND IT WILL BE UPDATED AS WE MOVE THROUGH 21 

THE STUDY. SO SORT OF LOOKING HERE AT THE SECOND HALF OF THIS 22 

SLIDE, HOW DOES THE CURRENT STATE OF FARE COORDINATION AND 23 

INTEGRATION AFFECT TRAVELERS AND LIMIT RIDERSHIP? SO WE WERE 24 

GOING TO EVALUATE THOSE IMPACTS IN THE FOLLOWING AREAS. AND 25 
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THIS IS, YOU KNOW, WE'RE TRYING TO BREAK DOWN A COMPLEX ISSUE 1 

INTO SEVERAL SIMPLE PIECES, AND THIS IS AN AREA WHERE YOU'RE 2 

INPUT IS GOING TO BE IMPORTANT. WAY WE HAVE CHOSEN TO BREAK IT 3 

DOWN IS, ONE, CUSTOMER VALUE CURRENT FARE POLICIES CAN LEAD TO 4 

DISCONNECT BETWEEN FARE CHARGE AND VALUE A CUSTOMER PLACES ON 5 

THEIR TRIP. SPOKEN TO THIS MORNING. PAYMENT EXPERIENCE. SO 6 

CURRENT FARE PRODUCTS PASSES PAYMENT TECHNOLOGIES AND PAYMENT 7 

EXPERIENCES MAY NOT BE LEGIBLE OR EASILY UNDERSTOOD. THREE. 8 

EQUITY, WE HAVE ALSO BEGUN TO ADDRESS THIS MORNING CURRENT 9 

FARES MAY NOT CONSISTENTLY MEET THE NEEDS OF VULNERABLE 10 

POPULATIONS AND FOUR FUTURE TRANSIT CURRENT FARES MAY NOT 11 

OPTIMIZE RIDERSHIP AND BENEFITS OF TRANSPORTATION IMPOSED 12 

INVESTMENTS. THAT'S THE CORE OF THE PROBLEM STATEMENT. IF YOU 13 

CAN MOVE TO THE NEXT SLIDE PLEASE. THIS ONE IS A LITTLE MORE 14 

DETAILED. SO THE -- IN ORDER TO STAY SIMPLE, WE HAVE KEPT 15 

THOSE CORE STATEMENTS HIGH LEVEL, BUT THIS STABLE HERE KIND OF 16 

LAYS OUT SORT OF SOME EXAMPLES -- AND SOME KEY CHALLENGES TO 17 

INVESTIGATE RELATED TO EACH OF THE CORE STATEMENTS AND I DON'T 18 

WANT TO READ THOSE, BUT THE COLUMN ON THE LEFT HERE CAN SORT 19 

OF HELP CLARIFY WHAT IT IS EXACTLY THAT WE MEAN IN EACH OF 20 

THOSE AREAS. AND THEN WE CAN CERTAINLY -- THAT SLIDE THERE IS 21 

PROBABLY WHERE WE WANT TO FOCUS OUR ATTENTION, WHILE WE 22 

DISCUSS IT, BUT I DID WANT TO POINT OUT, IF YOU LOOK ON THE 23 

NEXT SLIDE, AND IT'S REALLY THE NEXT THREE HERE, OUR 24 

CONSULTANT TEAM, AND BILL MENTIONED IT'S A TEAM LED BY STEER 25 
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THAT GOT A LOT OF EXPERIENCE DOING CITIES LIKE THIS, BOTH 1 

DOMESTICALLY IN THIS COUNTRY AND INTERNATIONALLY THEY LAID OUT 2 

A DRAFT RESEARCH PLAN FOR DATA THEY WOULD LIKE TO HELP US 3 

COLLECT AND SOME ANALYSIS THAT WE CAN BEGIN DOING FOCUSED 4 

AROUND THE PLANKS IN THIS PROBLEM STATEMENT. SO, LET'S SEE. 5 

MAYBE I'LL JUST WRAP UP ON SLIDE 22, SO IF YOU COULD SKIP 6 

FORWARD A COUPLE OF SLIDES. SO -- AND THESE ARE SOME QUESTIONS 7 

THAT WE HAVE PUT OUT TO SORT OF QUEUE UP YOUR THINKING. DOES 8 

THE PROBABLE STATEMENT EFFECTIVELY CAPTURE THE DECISION MAKING 9 

FACTORS FOR RIDING TRANSIT? DOES THE PROBLEM STATEMENT IMPACT 10 

THE COVID STATEMENT ADEQUATELY DOES THE PROBLEM STATEMENT 11 

CAPTURE ISSUES AROUND EQUITY APPROPRIATELY, AND THEN OF COURSE 12 

ANY FEEDBACK ISSUES SUGGESTIONS. WE ARE OPEN TO YOUR INPUT 13 

NOW. SO MAYBE ADINA I'LL TURN IT BACK TO YOU FOR DISCUSSION.  14 

 15 

ADINA LEVIN: IN TERMS TO -- REMIND ME, IF THERE IS AN 16 

ADDITIONAL SECTION FOLLOWING THIS ONE IN TERMS OF MANAGING THE 17 

TIME?  18 

 19 

MICHAEL EISEMAN: YEAH. WE HAVE ONE MORE SECTION, WHICH IS USER 20 

RESEARCH.  21 

 22 

ADINA LEVIN, CHAIR: OKAY GREAT. OKAY. SO ON THOSE PROBLEM 23 

STATEMENTS, ANY COMMENTS OR QUESTIONS ABOUT THIS AT THIS TIME? 24 
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AND I'M LOOKING FOR HANDS. SO I DO HAVE A COMMENT OR A 1 

QUESTION, BUT WANT TO WAIT FOR OTHER PEOPLE TO JUMP IN HERE.  2 

 3 

MICHAEL EISEMAN: ACTUALLY ADINA CAN I HOMELAND MAYBE IF WE 4 

DISPLAY SLIDE 18, THAT MAYBE WILL HELP PEOPLE REMEMBER WHAT 5 

THE PROPOSED PROBLEM STATEMENT IS.  6 

 7 

ADINA LEVIN: OKAY. SO WHILE PEOPLE ARE PONDERING, I'M SEEING 8 

THE LANGUAGE IN HERE ABOUT VALUE, BUT NOT LANGUAGE ABOUT 9 

RIGHT, FOR LACK OF A BETTER TERM, AND, YOU KNOW, DO WE WANT TO 10 

HAVE A CONCEPT OF HOW MUCH MOBILITY, AS A POLICY MATTER, DO WE 11 

WANT TO BE EXPECTING TO PROVIDE FOR PEOPLE AND I HAVE SOME 12 

ADDITIONAL QUESTIONS ABOUT EQUITY BUT WILL HOLD THEM BECAUSE 13 

OTHER PEOPLE HAVE HANDS. RANDI KINMAN?  14 

 15 

RANDI KINMAN: THANK YOU. I REALIZE THIS IS A GROUP 16 

SPECIFICALLY DISCUSSING FARE COORDINATION, AND INTEGRATION, 17 

BUT I THINK THAT PART OF THE ISSUE THAT WE HAVE IS ACTUALLY 18 

ACCESS, AND I'M WONDERING HOW THAT PLAYS INTO THE SCENARIO 19 

DOWN THE LINE. BECAUSE IT DISAPPOINT -- DOESN'T MATTER IF YOU 20 

MAKE IT. IF I DON'T HAVE ACCESS, I'M NOT RIDING. SO, DOES -- 21 

IS THAT SOMETHING THAT WE CAN TIE INTO? AND I KNOW THAT'S 22 

GOING TO BE PART OF THE ONGOING BLUE RIBBON TASK FORCE, BUT I 23 

THINK THAT WE JUST NEED TO STICK A PIN IN THAT PROBLEM RIGHT 24 

NOW, AND ACKNOWLEDGE THAT IT -- IT'S A COMBINED PROBLEM.  25 



               July 30, 2020 

 42 

 1 

ADINA LEVIN, CHAIR: UH, HUH.  2 

 3 

MICHAEL EISEMAN: RANDI CAN I ASK YOU, WHEN YOU SAY ACCESS, IN 4 

THE ADA SENSE? OR ACCESS FOR PEOPLE WITH MOBILITY CHALLENGES? 5 

OR JUST GETTING TO THE STATION IN GENERAL?  6 

 7 

RANDI KINMAN: JUST GETTING TO PLACES, AND I WILL USE MY 8 

EXPERIENCES AS A COMMUNITY COLLEGE TRUSTEE. OUR COMMUNITY 9 

COLLEGES ARE ALL BUILT OUTSIDE THE CITY CORE FOR THE MOST PART 10 

SO THEY'RE NOT ON GENERALLY STANDARD BUS LINES AND THAT MAKES 11 

IT HARD FOR OUR STUDENTS TO HAVE -- AND THESE ARE THE PEOPLE 12 

WE NEED TO SERVE -- IT MAKES IT REALLY DIFFICULT FOR THEM TO 13 

USE TRANSIT BECAUSE I DON'T CARE IF YOU'RE ONLY PAYING A 14 

DOLLAR A DAY, YOU'RE NOT GETTING TRANSIT SERVICE THAT ALLOWS 15 

YOU TO GET BACK AND FORTH TO CAMPUS. SO THOSE ARE THE 16 

SITUATIONS THEY WANT TO MAKE SURE THAT WE ACKNOWLEDGE GOING 17 

FORWARD ON THIS.  18 

 19 

WILLIAM BACON: I WAS GOING TO ADD, I THINK WE'RE VERY 20 

COGNIZANT OF THE FACT THAT FARE POLICY IS ONE PLANK IN A LARGE 21 

SORT OF PUZZLE OF IMPROVING ACCESS TO TRANSIT, IMPROVING 22 

TRANSIT AS A WHOLE. SO I THINK THAT'S WHY WE'RE TRYING TO BE 23 

VERY DELIBERATE IN THE PROBLEM STATEMENT IN SAYING THAT FARE 24 

POLICY IS ONE OF THE BARRIERS TO TRANSIT, AND YOU KNOW IF WE 25 
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WANT TO HAVE A BEST TRANSIT SYSTEM, THAT WE -- THAT WE'RE 1 

TRYING TO ACHIEVE IN THIS REGION, YOU KNOW, HOW CAN FARE 2 

POLICY PLAY ITS PART IN BRINGING THAT VISION TO FRUITION AND 3 

HAVING A ROBUST SYSTEM THAT DOES PROVIDE ACCESS TO THE BEST 4 

EXTENT IT POSSIBLY CAN? SO WE NEED TO FIGURE OUT, AGAIN, IN 5 

THE PROJECT ITSELF, HOW WE ACKNOWLEDGE THAT AND MAKE THAT 6 

CLEAR, THAT THERE ARE THESE OTHER BARRIERS, AND I THINK THAT'S 7 

SOMETHING THAT OUR FARE INTEGRATION TASK FORCE IS INTERESTED 8 

IN SO THOSE ARE THE GENERAL MANAGERS RELYING THAT RELIABILITY, 9 

FREQUENCY, ACCESS TO THE SERVICE AT ALL ARE REALLY FUNDAMENTAL 10 

QUESTIONS AND CHALLENGES AS WELL.  11 

 12 

RANDI KINMAN: THANK YOU. JUST SO WE CARRY IT ALONG.  13 

 14 

ADINA LEVIN: OKAY NEXT IS IAN GRIFFITHS.  15 

 16 

IAN GRIFFITHS: SOMETHING THAT'S MISSING FROM THIS PROBLEM 17 

STATEMENT IS WHAT IS IN FACT OUR CURRENT FARE POLICY ON 18 

SERVICE DESIGN? SO, HOW TRANSIT AGENCIES MAKE DECISIONS ON 19 

WHAT SERVICE TO PROVIDE, AND WHERE. I THINK THAT IS A BIG FARE 20 

POLICY, AND REALLY HOW THE DIFFERENT DEPENDENCIES THAT THE 21 

TRANSIT AGENCIES HAVE ON REVENUES BECAUSE ESSENTIALLY EVERYONE 22 

IS COLLECTING ONLY THEIR REVENUE FROM THEIR OWN CUSTOMERS IT'S 23 

NOT BEING SHARED IT'S NOT BEING SPLIT UP OPERATORS ARE NOT 24 

BEING COMPENSATED ON A BASIS -- IT'S JUST BEING LIKE, YOU KNOW 25 
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IF YOU PICK UP A PASSENGER YOU GET THE FULL FARE FROM THAT AND 1 

THAT SYSTEM TO ME WHICH IS PART OF OUR FARE POLICY GREATLY 2 

INFLUENCES A TRANSIT AGENCY'S DECISION TO PROVIDE SERVICE IN 3 

SOME AREAS VERSUS OTHERS AND IT IS CONNECTED TO THE OVERALL 4 

CONVENIENCE AND LEVEL OF INTEGRATION TO OUR NETWORK. I WOULD 5 

LOVE FOR THIS STUDY TO ACKNOWLEDGE THAT FARES AND FARE POLICY 6 

IS CONNECTED TO OUR ABILITY TO DESIGN AND PROVIDE INTEGRATED 7 

CONVENIENT SERVICE FOR USERS. BECAUSE THERE IS AN INEQUAL -- 8 

THERE ISN'T CONSISTENT INCENTIVES FOR TRANSIT AGENCIES TO 9 

PROVIDE MORE SERVICE WHEN, YOU KNOW, WHEN THEY'RE NOT 10 

ESSENTIALLY BEING -- THEY'RE ONLY COLLECTING -- THEY'RE GOING 11 

TO BASICALLY NOT PROVIDE SERVICE IN AREAS WHERE THERE IS LOWER 12 

RIDERSHIP OR BART IS GOING TO HAVE CERTAIN FINANCIAL MOTIVES 13 

TO PROVIDE CERTAIN TYPES OF TRANSIT SERVICE CALTRAIN IS GOING 14 

TO HAVE DIFFERENT MOTIVES. IS THAT HARD -- DO YOU SEE THAT AS 15 

PART OF THE STUDY OR SOMETHING THAT THE STUDY COULD HELP FLESH 16 

OUT IN TERMS OF IDENTIFYING THAT PARTICULAR BARRIER TO KIND OF 17 

THE SUPPLY SIDE OF LIKE WHAT SERVICE ENDS UP GETTING PUT OUT 18 

AS A RESULT OF THE CURRENT FARE POLICY?  19 

 20 

WILLIAM BACON: MIKE I DON'T KNOW IF YOU WANT TO ANSWER -- I 21 

THINK WE AGREE WITH WHAT YOU'RE SAYING IAN AND I THINK WE WERE 22 

TRYING TO CAPTURE THOSE CONCEPTS IN NUMBER FOUR, WHICH IS THE 23 

FUTURE TRANSIT SORT OF ISSUE, AND IF, AGAIN, IF YOU OR OTHERS 24 

HAVE FEEDBACK ABOUT HOW WE CAN BETTER FRAME THAT, I THINK WE 25 
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CAN TRY TO REWORK IT A LITTLE BIT TO CAPTURE WHAT YOU SAID BUT 1 

I THINK THIS'S THE SPIRIT OF WHAT YOU'RE GETTING AT IS WHAT 2 

WE'RE TRYING TO CAPTURE IN THAT ITEM NUMBER FOUR.  3 

 4 

IAN GRIFFITHS: I THINK IT COULD USE A SLIGHTLY MORE FINER 5 

POINT ON THAT. BUT YEAH, I FIGURED THAT'S PROBABLY WHERE IT 6 

BELONGS BUT MAYBE WE CAN -- I CAN OFFER SOME COMMENTS OFFLINE 7 

TO THAT.  8 

 9 

ADINA LEVIN, CHAIR: MOVING ON TO JONATHON KASS.  10 

 11 

JONATHON KASS: THANKS. TWO QUESTIONS OR COMMENTS, ONE RELATED 12 

TO THE COVID CONTEXT, I THINK WHAT YOU HAVE REALLY CAPTURES 13 

THE SERIOUS IMPACTS OF COVID, AND NOT JUST ON THE AGENCIES 14 

TODAY BUT ON THE WAY THE STUDY CAN BE CONDUCTED VERSUS HOW IT 15 

WAS ENVISIONED. TO ME, I FEEL LIKE THERE IS ANOTHER PIECE THAT 16 

MAYBE SHOULD BE PUT OUT MORE EXPLICITLY, I THINK THE LONG-TERM 17 

FINANCIAL CHALLENGES THAT ARE BEING CREATED SUGGEST THAT WE'LL 18 

BE HAVING TO PARE BACK OUR SYSTEM IN A WAY THAT MIGHT CREATE 19 

REDUNDANCIES HOW WE CAN MAKE OUR TRANSIT SYSTEM STREAMLINED 20 

WE'LL BE HAVING TO DEPLOY BUT THIS GOES WITHOUT SAYING I THINK 21 

THAT SIMPLY ELEVATES THE IMPORTANCE OF FARE COORDINATION AND 22 

INTEGRATED FARE SYSTEM BECAUSE YOU ARE GOING TO -- YOU'RE 23 

GOING TO HAVE, LIKELY, MORE PEOPLE USING MORE SYSTEMS. SOME 24 

WAY OF GETTING THAT POSSIBILITY IN THERE, TO ME, WOULD BE 25 
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USEFUL. AND THEN SECONDLY, YOU KNOW, I LIKE -- IF I UNDERSTAND 1 

-- I JUST WANT TO CONFIRM, IT SOUNDED LIKE -- I THINK IT MAKES 2 

A LOT OF SENSE THAT WE SPEND THIS TIME UP FRONT THINKING 3 

CAREFULLY ABOUT THE PROBLEM STATEMENT BUT IT SOUNDED LIKE YOU 4 

SAID, THESE ARE A LITTLE BIT LIVING STATEMENTS THAT WE MAY 5 

LEARN THINGS IN THE RESEARCH THAT CAUSE US TO HAVE TO GO BACK 6 

AND REVISIT OUR PROBABLE STATEMENT, AND THAT -- THERE IS SOME 7 

FLEXIBILITY TO DO THAT FOR ANY OF THESE TOPICS. DID I 8 

UNDERSTAND THAT RIGHT?  9 

 10 

MICHAEL EISEMAN: YES. THAT IS THE INTENDED APPROACH, AND IT IS 11 

CONSISTENT WITH THE APPROACH THAT OUR CONSULTANT TEAM HAS 12 

TAKEN ON SIMILAR STUDIES IN OTHER REGIONS, AND THEY HAVE FOUND 13 

IT TO BE SUCCESSFUL. SO, YES.  14 

 15 

JONOTHON KASS: GREAT. THANK YOU.  16 

 17 

ADINA LEVIN, CHAIR: COOL. RICH HEDGES.  18 

 19 

RICHARD HEDGES: THANK YOU. I JUST HAD TO SAY THAT I AGREE SO 20 

MUCH WITH ANDY AND ALSO WITH IAN AND THERE HAS TO BE SOME WAY 21 

IN OUR POLICY STATEMENT TO IDENTIFY THESE ISSUES HERE, BUT THE 22 

FARE INTEGRATION HAS TO BE -- OR SHOULD BE WORKED ON FIRST, AS 23 

OUR PRIMARY DUTY. BUT I WILL SAY THAT WITHOUT AN INTEGRATION 24 

OF SCHEDULES, IT'S REALLY AN EQUITY ISSUE. I HAVE WORKED WITH 25 
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SERVICE WORKERS ALL MY LIFE, AND SCHEDULES ARE VERY 1 

UNFORGIVING. PEOPLE GET WRITTEN UP REGULARLY WHEN THEY'RE LATE 2 

AND BY THE THIRD WARNING THEY'RE LOOKING FOR A JOB. AND TO A 3 

VERY LARGE EXTENT, WITH THE HUGE DELAYS SOMETIMES BETWEEN A 4 

BUS LEAVING BECAUSE I HAVE EXPERIENCE SAID THIS THREE OR FOUR 5 

MINUTES BEFORE CALTRAIN OR BART GETS IN THERE IS AN HOUR AND 6 

SOMETIMES MIDDAY, 90 MINUTES, YOU HAVE DESTROYED SOMEBODY'S 7 

WORK SCHEDULE. SO ALL OF THESE THINGS PUT TOGETHER ARE VERY 8 

MUCH EQUITY ISSUES. AND SO I WOULD LIKE TO SEE THEM 9 

ACKNOWLEDGED, BUT OUR PRIMARY FOCUS, I BELIEVE, IS ON THE FARE 10 

INTEGRATION POLICY. THANK YOU.  11 

 12 

ADINA LEVIN: COOL. SO MOVING ON, THANK YOU RICH. MOVING ON TO 13 

WENDI KALLINS.  14 

 15 

WENDI KALLINS: I GOT IT. IT TAKES A MINUTE TO UNMUTE. DRILLING 16 

DOWN FROM THE POLICY STATEMENTS FROM THE QUESTIONS TO ASK, AND 17 

THEN THE RESEARCH, I THINK IT'S VERY THOROUGH AND FOLLOWING 18 

THROUGH ON THAT, BUT THEN I DON'T SEE IN THE RESEARCH, WHERE 19 

YOU'RE LOOKING INTO GOOD EXAMPLES OF ALTERNATIVES TO BE ABLE 20 

TO PRESENT TO US. AND, SO, CAN YOU TELL ME WHERE I CAN FIND 21 

THAT? I SEE YOU NODDING, BILL. [LAUGHTER]  22 

 23 

WILLIAM BACON: YEAH SO, I THINK THE PROBLEM STATEMENT IS SORT 24 

OF TRYING TO FRAME HOW WE APPROACH THE RESEARCH AND THE 25 
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ANALYSIS WORK THAT THE PROJECT WILL UNDERTAKE. WE ALSO SORT OF 1 

SIMULTANEOUSLY RIGHT NOW HAVE ONGOING -- OUR CONSULTANT TEAM 2 

IS WORKING ON PREPARING SOME SORT OF BEST PRACTICES FROM 3 

AROUND THE WORLD IN TERMS OF FARE POLICY, PLANKS, OR GOOD -- 4 

BEST PRACTICES, I GUESS, I'LL JUST LEAVE IT AT THAT, FROM 5 

OTHER REGIONS AROUND THE WORLD, AND I THINK WHERE THE PROJECT 6 

WILL EVENTUALLY LEAD, IS THAT BASED ON THIS RESEARCH AND 7 

ANALYSIS, WE WILL END UP PROPOSING SEVERAL DIFFERENT 8 

ALTERNATIVES THAT WILL BE ANALYZED IN THE PROJECT, AND OVER 9 

THE COMING YEAR, WE WILL BE COMING TO THE SUBCOMMITTEE AND TO 10 

OTHER STAKEHOLDER BODIES, AS WE FORMULATE THOSE ALTERNATIVES 11 

WE WILL BE ANALYZING SO THOSE WILL BE SPECIFIC IDEAS THAT WE 12 

WILL BE TESTING IN THIS PROJECT TO SAY, IF WE HAD A, YOU KNOW, 13 

AS AN EXAMPLE, A SINGLE LOCAL BUS FARE ACROSS THE BAY AREA, 14 

WHAT WOULD THAT MEAN? IF WE HAD A CERTAIN DISCOUNT POLICY, 15 

WHAT WOULD THAT MEAN? AND IN THESE DIFFERENT ALTERNATIVE BE 16 

TESTING THAT. THIS GROUP WILL BE PART IN DETERMINING AND 17 

FORMULATING THOSE IN PART OF WHAT WE WILL BE TESTING. THIS IS 18 

SORT OF LIKE THE RESEARCH PLAN AND THEN WE'LL BE COMING BACK 19 

WITH SORT OF A UNIVERSE OF BEST PRACTICE IDEAS THAT OUR 20 

CONSULTANT TEAM IS WORKING ON AND REFORMULATING THAT INTO 21 

SOMETHING THAT WE'LL TEST FOR OUR REGION. DOES THAT MAKE 22 

SENSE?  23 

 24 
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WENDI KALLINS: YEAH. THANK YOU. I JUST WANTED TO SEE -- IT 1 

WOULD BE NICE IF IT WAS IN THE DOCUMENT SOMEWHERE JUST SO WE 2 

KNOW THAT'S GOING ON. I THINK IT WOULD BE GOOD TO ADD THAT. 3 

AND I WANT TO ADD MY VOICE TO THE DILEMMA WE HAVE BEEN SILOED 4 

INTO TALKING ABOUT FARES, AND YET FARES AND SYSTEM INTEGRATION 5 

-- YOU KNOW, ROUTE INTEGRATION, ARE DIRECTLY LINKED. SO THAT 6 

IS A PROBLEM, I THINK, THAT DOES NEED TO BE SOLVED, SO THAT WE 7 

CAN BE LOOKING AT HOW THAT -- HOW THOSE THINGS INTERCONNECT, 8 

AND HOW THEY RELATE AND AFFECT EACH OTHER.  9 

 10 

ADINA LEVIN: GREAT. COOL. OKAY. SO MOVING ON TO TISHA HARTMAN.  11 

 12 

SPEAKER: HI. THANK YOU. ONE OF THE THINGS WHEN YOU WERE ASKING 13 

THE QUESTION IS, ARE THE QUESTIONS WE'RE ASKING INCLUSIVE 14 

ENOUGH. ONE OF THE THINGS THAT'S OBVIOUS TO ME CAN WHICH IS A 15 

BARRIER TO RIDERSHIP SOMETHING OUT OF THE SCOPE OF THIS 16 

COMMITTEE, BUT SOMETHING THAT SHOULD BE ON THE BOARD IS THE 17 

PERCEPTION OF PUBLIC SAFETY AS A WOMAN AND COMMUTER THAT WOULD 18 

BE GOING TO LONG DISTANCES, ARE YOU KNOW, AFTER HOURS OR 19 

POTENTIALLY LATE AT NIGHT THAT'S ALWAYS BEEN A CONSIDERATION 20 

FOR ME WHEN I'M CONSIDERING PUBLIC TRANSIT I DON'T THINK YOU 21 

CAN HAVE A DISCUSSION AND NOT HAVE THAT ON THE TABLE AS WELL. 22 

SECOND THING, WHEN YOU LOOK AT THE FARES THAT ARE PRESENTED IN 23 

THE PACKET, I SEE, REALLY, JUST A FEW DEMOGRAPHICS. I SEE 24 

CHILD, YOUTH, AND SENIOR, AND IN ABSENCE OF MORE DEMOGRAPHIC 25 
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DATA, AND INTEREST OF EQUITY, AND IN REACHING THE UNDERSERVED 1 

COMMUNITIES AND IN GROWING RIDERSHIP, I THINK THERE IS REAL 2 

OPPORTUNITY TO ADD A FINANCIAL NEEDS SEGMENT, WHICH WOULD BE 3 

LIKE YOUR SECTION-EIGHT VOUCHER, RECIPIENTS EBT RECIPIENTS, 4 

STUDENTS AND ALSO PUBLIC SERVANT OPPORTUNITY, HEALTH CARE 5 

WORKERS POLICE OFFICERS, FIREMEN, AND THEN OBVIOUSLY A 6 

COMMUTER SEGMENT. MAYBE THE COMMUTER SEGMENT SUBSIDIZES THE 7 

FULL PRICE GROUPS, AND I THINK THERE IS OPPORTUNITY IN 8 

DEMOGRAPHIC IN FARE BREAK DOWNS. AND THAT'S IT.  9 

 10 

WILLIAM BACON: THIS IS BILL, AND I'LL ADD, THE CHART IN 11 

ATTACHMENT B TO THIS ITEM I THINK ADDRESSES YOUR COMMENT. 12 

BREAK DOWN IN CATEGORIES. THERE ARE TWO CATEGORIES THAT MAY 13 

NOT BE EXPLICIT ONE IS LABELED RTC STANDS FOR REGIONAL TRANSIT 14 

CONNECTION THAT'S PRIMARILY PEOPLE WITH DISABILITIES WHO HAVE 15 

ACCESS TO A DISCOUNT CATEGORY THAT, IN THE BAY AREA FOR RTC SO 16 

THAT HAVE BEEN CLARIFIED ON THAT HAND OUT AND THE COLUMN FAR 17 

RIGHT ON ATTACHMENT B REFERS TO A MEANS-BASED DISCOUNT BRANDED 18 

AT CLIPPER START WHICH LAUNCHED THIS MONTH AND PROVIDES A 19 

DISCOUNT TO PASSENGERS BASED ON QUALIFYING INCOME OF THEIR 20 

HOUSEHOLD. AND THE ORIGINAL PILOT PROGRAM FOR THE CLIPPER 21 

START PROGRAM WAS JUST FOR FOUR OPERATORS SFMTA CALTRAIN BART 22 

AND GOLDEN GATE BUT ACTUALLY PARTIALLY BECAUSE OF THE PANDEMIC 23 

BEING EXPANDED TO A LONGER INCLUSIVE LIST OF OPERATORS ACROSS 24 

THE REGION LATER THIS YEAR AND THE DISCOUNT RATES THAT ARE 25 
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BEING OFFERED ARE BEING ADJUSTED AS WELL MOSTLY TO A 50 1 

PERCENT DISCOUNT SO THAT INFORMATION IS STILL INFLUX AND 2 

CHANGING SINCE OPERATORS HAVE DECIDED TO EXPAND THE MEANS-3 

BASED PROGRAM THROUGH THE CLIPPER START PILOT BUT THIS PROJECT 4 

ITSELF WILL ABSOLUTELY BE LOOKING AT HOW AN INCOME BASED FARE 5 

PRODUCT COULD WORK, INFORMED BY THE PILOT THAT IS NOW ON THE 6 

STREET TODAY.  7 

 8 

ADINA LEVIN: COOL. SO SEEING NO ADDITIONAL HANDS, I WANT TO 9 

CHIME IN BEFORE WE MOVE INTO THE LAST PIECE OF THE 10 

PRESENTATION, AND I HAVE ONE KIND OF BIG POINT, AND ONE 11 

SMALLER POINT BUILDING ON WHAT SOME PEOPLE HAVE SAID. THERE 12 

HAS BEEN A NUMBER OF PEOPLE BRINGING UP THE THEME OF EQUITY, 13 

AND I WOULD LOVE TO SEE, YOU KNOW, THE PROBLEM STATEMENT AS A 14 

HIGH LEVEL, BUT I THINK IN ORDER TO ADDRESS IT, I THINK THAT 15 

IT WILL BE IMPORTANT TO DRILL DOWN INTO A NUMBER OF DIFFERENT 16 

NUANCES THAT GET AT THAT ISSUE. BECAUSE THERE ARE A NUMBER OF 17 

DIFFERENT FINANCIAL BARRIERS, AND IT'S NOT ALL ONE THING. SO 18 

FOR EXAMPLE, THE MEANS-BASED FARE DISCOUNT ADDRESSES 19 

HOUSEHOLDS WITH LESS THAN TWO X OF THE POVERTY LEVEL WHICH IS 20 

50,000 FOR A FAMILY OF FOURS BUT WE KNOW THAT FOR HOUSING 21 

AFFORDABILITY, IT'S IN THE 70 THOUSANDS OF HOUSEHOLD INCOME 22 

WHERE YOU'RE CLASSIFIED AS VERY LOW INCOME. SO THERE ARE 23 

HOUSEHOLDS THAT MAKE 50 PERCENT MORE THAN WOULD QUALIFY FOR 24 

THIS MEANS-BASED FARE BUT THAT ARE STILL SEVERELY ECONOMICALLY 25 
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CHALLENGED TO LIVE WITH A ROOF IN THE BAY AREA. SO I THINK 1 

THAT IS ONE ELEMENT. ANOTHER ELEMENT IS IN TERMS OF COST 2 

CONTENDING TO DRIVING WE KNOW ABOUT TWO THIRD'S OF BAY AREA 3 

WORKING POOR PEOPLE ARE COMMUTING BY CAR. SO, THE QUESTION 4 

ABOUT WHAT IS AFFORDABLE, PEOPLE ARE CLEARLY VOTING WITH THEIR 5 

WHEELS THAT, MAYBE THERE IS OTHER REASONS THAT PEOPLE ARE 6 

DRIVING, BUT IF SOME OF IT IS AFFORDABILITY, IS IT BECAUSE 7 

DRIVING IS PERCEIVED AS MORE AFFORDABLE THAN TAKING TRANSIT. 8 

SO THAT IS ANOTHER DEFINITION OF AFFORDABILITY AND EQUITY. 9 

ANOTHER ISSUE IS NOT SO MUCH ABOUT INCOME AS CASH FLOW. SO 10 

HOUSEHOLDS THAT ARE LOWER IN RESOURCES, MAY HAVE A CERTAIN 11 

LEVEL OF INCOME, BUT IT IS, YOU KNOW, ONE WAY THAT OUR REGION 12 

PROVIDES LOWER TRANSIT FARES IS BY HAVING A MONTHLY PASS. BUT 13 

IN ORDER TO HAVE A MONTHLY PASS, YOU NEED TO BE ABLE TO PUT 14 

$75 UP AT THE BEGINNING OF THE MONTH WHICH IS NOT SOMETHING 15 

THAT EVERYONE CAN DO. SO THERE IS, YOU KNOW, LOOKING AT THE 16 

ISSUE OF CASH FLOW IN TERMS OF WHAT IT MEANS TO BE AFFORDABLE. 17 

AND THEN ANOTHER -- AND I'M NOT GOING TO EXHAUST THIS LIST, 18 

BUT THIS THINKING SHOULD GET FLESHED OUT. ANOTHER IS ABOUT THE 19 

DISTANCE OF TRAVEL BY INCOME LEVELS. WE KNOW THAT THERE HAS 20 

BEEN A TREMENDOUS AMOUNT OF DISPLACEMENT AND SUBURBANIZATION 21 

OF POVERTY AND PEOPLE OF COLOR AND LOW INCOME PEOPLE WHO HAVE 22 

MOVED OUT TO FURTHER REGIONS AND TAKE LONGER TRIPS SUCH THAT 23 

IF WE HISTORICALLY THOUGHT OF LONG TRIPS AS LUXURY AND IT'S 24 

GOOD TO CHARGE MONEY BUT WE'RE SEEING LOW INCOME PEOPLE FACING 25 
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LONG TRIPS WHAT DOES THIS MEAN IN TERMS OF EQUITY IN TERMS OF 1 

PRICING STRUCTURE SO MORE NUANCED AND RICHNESS ABOUT EQUITY 2 

AND WHAT THE DIFFERENT CHALLENGES ARE FOR AFFORDABLE AND WHAT 3 

KINDS OF SOLUTIONS MIGHT ADDRESS THOSE. AND THAT'S THE END OF 4 

THAT. LAST ELEMENT IS SEVERAL PEOPLE HAVE MENTIONED THERE IS 5 

OTHER ISSUES THAT ARE RELATED TO FARES AND FARE POLICY AND 6 

FARE INTEGRATION. AND THIS HAS BEEN SUCH A CHALLENGING ISSUE 7 

FOR OUR REGION TO FINALLY DECIDE TO TAKE ON, THEY WOULD IN NO 8 

WAY WANTED TO SEE US TAKING OUR EYE OFF THE BALL. I THINK WE 9 

HAVE THIS OPPORTUNITY TO TAKE THIS ON, BUT AT THE SAME TIME 10 

PEOPLE WILL BE COMING FORWARD WITH MANY ADDITIONAL GOOD IDEAS 11 

ABOUT IMPROVING THE SYSTEM AND WOULD LOVE TO HEAR FROM STAFF 12 

AND HAVE STAFF THINK ABOUT HOW CAN WE CAPTURE THOSE IDEAS AND 13 

FEED THEM TO AN APPROPRIATE PLACE SO WE CAN THINK ABOUT HOW 14 

GOOD IDEAS DON'T GET LOST BUT ALSO THAT WE DON'T LOSE THE 15 

OPPORTUNITY TO -- THIS VALUABLE THING. AND THOSE ARE MY 16 

COMMENTS. IF STAFF HAS COMMENTS, WE CAN MOVE ON TO THE 17 

REMAINDER OF THE PRESENTATION. AND I WOULD LIKE US TO BE DONE 18 

BY NOON  19 

 20 

WILLIAM BACON: THE POINTS YOU'RE BRINGING UP ABOUT DISTANCE 21 

TRAVELED AND DISPLACEMENT THROUGHOUT THE REGION HAS BEEN 22 

EXPERIENCING FOR A NUMBER OF YEARS ARE IMPORTANT AND SOMETHING 23 

WE NEED TO DO ANALYSIS ON THE STUDY AND PRESENT DATA SHOWING 24 

HOW THE AVERAGE FARE PAID BY A HOUSEHOLD BASED ON THEIR INCOME 25 
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MIGHT NOT REALLY REFLECT THE VALUE OF THAT TRIP, NECESSARILY 1 

IN TERMS OF WHAT WE'RE CHARGING. SO I THINK THAT'S SOMETHING 2 

THAT REALLY HAS CHANGED A LOT SINCE OUR SYSTEMS WERE 3 

CONSTRUCTED OR ADMINISTRATIVELY CREATED, TYPICALLY 50 TO 70 4 

YEARS AGO AT THIS POINT. WHERE MANY PEOPLE ARE ABLE TO LIVE 5 

CLOSE TO WHERE THEY WORKED, AND THAT MIGHT NOT BE THE CASE FOR 6 

MANY PEOPLE TODAY YOU MIGHT HAVE TO TAKE TWO OR THREE SYSTEMS 7 

TO GET FROM YOUR PLACE OF RESIDENT OR EDUCATION OR JOB OR 8 

FACILITIES ET CETERA. I WOULD JUST SAY WE'RE COGNIZANT OF THAT 9 

AS WELL AND INTEND TO LOOK AT THAT IN OUR WORK.  10 

 11 

ADINA LEVIN, CHAIR: GREAT. THANK YOU. SO WITH THAT, SINCE I 12 

DON'T SEE ANY OTHER HANDS ON THIS TOPIC, LET'S GET AN UPDATE 13 

ON USER RESEARCH AND HOW ON EARTH CAN WE DO RESEARCH IN THE 14 

ERA OF COVID. HANDING IT BACK TO STAFF.  15 

 16 

WILLIAM BACON: I CAN START OFF AND IF MIKE E HAS THOUGHTS, HE 17 

CAN JUMP IN. IF WE CAN PULL UP THE SLIDES, SLIDE 24 PLEASE. GO 18 

ON TO NUMBER 24, THE NEXT ONE. SO AS WE TALKED ABOUT A MOMENT 19 

AGO, YOU KNOW, ONE OF THE MOST IMPORTANT PARTS OF THIS 20 

PROJECT, WHEN THE SCOPE WAS DEVELOPED, AND WHEN THE MTC 21 

COMMISSION APPROVED AN ALLOCATION OF REGIONAL MEASURE TWO 22 

BRIDGE TOLL FUNDS ABOUT $900,000 TO SUPPORT THIS WORK AND THE 23 

CONSULTANT TEAM, WAS USER RESEARCH. AND ABOUT A THIRD OF OUR 24 

ENTIRE PROJECT BUDGET WAS INTENDED TO BE SPENT DOING USER 25 
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RESEARCH, TALKING TO PEOPLE, OUT ON THE STREET, YOU KNOW, IN 1 

STATIONS, ON BUSES, EXPERIENCING THE SYSTEM, AND LEARNING FROM 2 

THEM, AND HELPING GUIDE OUR WORK BY THE EXPERIENCE OF THE 3 

PEOPLE WHO USE TRANSIT EVERY DAY. AS WELL AS BY TALKING TO 4 

PEOPLE WHO DON'T USE TRANSIT VERY MUCH, TO UNDERSTAND HOW THE 5 

BARRIERS TO THE SYSTEM IMPACT THAT CHOICE IN TERMS OF NOT 6 

USING TRANSIT. AND AS I THINK ALL OF US HAVE EXPERIENCED OVER 7 

THE LAST FOUR MONTHS, COVID HAS UPENDED EVERYTHING THAT WE 8 

HAVE PLANNED. AND YOU KNOW, BEFORE THE PANDEMIC WE HAD HOPED 9 

TO LEARN FROM THIS USER RESEARCH, REALLY THE EXPERIENCE, AND 10 

OUR CONSULTANTS PHRASED IT AS THE MEANING OF TAKING TRANSIT IN 11 

TERMS OF WHAT OPPORTUNITIES TRANSIT PROVIDES THEM, AND THE 12 

VALUE OF WHAT TRANSIT MEANS TO THEIR LIVES IN TERMS OF HOW 13 

OPPORTUNITIES THAT THEY WOULDN'T HAVE OTHERWISE HAVE ACCESS 14 

TO, ARE ACCESSIBLE BY TRANSIT, OR HOW THEY'RE NOT, OR HOW 15 

TRANSIT FORMS BARRIERS TO THEM REALLY ACHIEVING OPPORTUNITIES 16 

THEY WOULD LIKE TO ACHIEVE BECAUSE THE SCHEDULE ISN'T 17 

COORDINATED OR BECAUSE THE SCHEDULE ISN'T FREQUENT OR RELIABLE 18 

ENOUGH. WE WANT TO HEAR FROM THE PEOPLE IN OUR REGION. WE PLAN 19 

TO DO THIS THROUGH AWE VARIETY OF DIFFERENT MECHANISMS, AND 20 

OUR CONSULTANT TEAM IS A FARMER NAMED OXD WHICH IS A USER 21 

RESEARCH AND DESIGN FIRM THAT SPECIALIZES IN CREATIVE ON THE 22 

GROUND ALMOST ANNE THROW APOLOGY RESEARCH USING SYSTEMS LIKE 23 

TECHNOLOGY SYSTEMS TRANSIT SYSTEMS PARK SYSTEMS THINGS LIKE 24 

THAT. THEY ARE BASED IN VANCOUVER COLUMBIA AND VANCOUVER, THEY 25 
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HAVE DONE POLICY BADE WORK IN THE REGION AND DONE CUTTING EDGE 1 

USER RESEARCH ABOUT FARE POLICY FOR THE TRANSIT OPERATOR IN 2 

VANCOUVER WHICH IS TRANCE LINK THAT WAS ATTRACTIVE TO THE 3 

PROCUREMENT SELECTION PANEL WHICH CONSISTED OF MTC AND BART 4 

AND OTHER TRANSIT OPERATOR STAFF, AND WE WERE VERY INTERESTED 5 

IN BRINGING THEIR APPROACH TO OUR REGION, AND SORT OF LEARNING 6 

FROM WHAT THEY HAVE LEARNED IN VANCOUVER, AND BEING ABLE TO 7 

TRANSLATE THAT INTO INSIGHTS FROM OUR CUSTOMERS. NOW, MOST OF 8 

THAT INVOLVED IN-PERSON INTERACTION FROM STAFF FROM THE 9 

CONSULTANT, RIDING BUSES, RIDING TRAINS, BEING IN STATIONS, 10 

DEVELOPING MOCK FARE, YOU KNOW, CHARTS AND MAPS, AND YOU KNOW, 11 

ASKING USERS TO INTERACT WITH THEM AND EXPERIENCE THOSE 12 

PROPOSED SYSTEMS SO GETTING AT A QUESTION WENDY ASKED A MOMENT 13 

AGO, LATER IN THE STUDY WHEN WE HAVE ALTERNATIVE FARE CONCEPTS 14 

OR POLICIES TO LOOK AT, PROTOTYPING THEM AND ACTUALLY 15 

DEVELOPING COLLATERAL THAT YOU WOULD SHOW PEOPLE AND SAY DOES 16 

THIS MAKE SENSE TO YOU HOW WOULD YOU INTERACT WITH THIS DOES 17 

THIS CHANGE HOW WOULD YOU TAKE YOUR TRIP AND TRYING TO 18 

UNDERSTAND FROM USERS HOW FARE POLICY AFFECTS THEM AND HOW 19 

CHANGES TO POLICY COULD IMPACT THEIR BEHAVIOR IN THE SYSTEM. 20 

WE ARE TRYING TO FIGURE THIS OUT AS WE GO IN TERMS OF HOW TO 21 

ADAPT THIS BECAUSE NOT ONLY ARE WE NOT ABLE TO REALLY HAVE 22 

FACE-TO-FACE INTERACTIONS, BUT OUR TRANSIT RIDERSHIP IS DOWN 23 

70 TO 90 PERCENT DEPENDING ON THE OPERATOR YOU'RE TALKING 24 

ABOUT, AND THE INDIVIDUALS USING TRANSIT MIGHT NOT, IN ANY WAY 25 
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FEEL COMFORTABLE SPEAKING TO PEOPLE WHILE MAKING THEIR TRIP, 1 

IS THEN BEYOND THAT WE'RE MISSING A HUGE SEGMENT OF 2 

INDIVIDUALS WHO WOULD HAVE BEEN TYPICALLY RIDING TRANSIT, AND 3 

THEIR EXPERIENCES AND PERSPECTIVES WOULD BE LOST IF WE DID 4 

USER RESEARCH EXCLUSIVELY BASED ON WHO IS USING THE SYSTEM 5 

TODAY. SO WE'RE TRYING TO REGROUP AND THIS IS REALLY WHERE 6 

WE'RE LOOKING FOR EXPERTISE FROM THE SUBCOMMITTEES SINCE MANY 7 

OF YOU CLOSER TO STAKEHOLDER GROUPS AND COMMUNITY-BASED 8 

ORGANIZATIONS THAN WE ARE NECESSARILY AS STAFF, AND WE HAVE 9 

DISCUSSED WITH OUR CONSULTANT, ONE IDEA WHICH INVOLVES HOSTING 10 

A SERIES OF -- WHAT THE CONSULTANT DESCRIBES AS NARRATIVE 11 

WORKSHOPS WHICH WOULD BRING TOGETHER IDEALLY, A VERY DIVERSE 12 

RANGE OF STAKEHOLDERS IN A VERY FOCUSED CONVERSATION, TRYING 13 

TO GET AT THOSE SAME KINDS OF QUESTIONS WE WOULD BE ASKING IN 14 

PERSON ABOUT HOW TAKING TRANSIT OFFERS VALUE, OR BARRIERS TO 15 

YOUR LIFE, AND ACCESS TO OPPORTUNITY, HOW LEGIBLE AND 16 

COMPREHENSIBLE OUR FARE SYSTEM IN AND WHAT THAT MEANS IN TERMS 17 

OF A DECISION MAKING PROCESS IN USING THE SYSTEM AND TRYING TO 18 

COLLECT INSIGHTS IN THE FRONT STAGE OF THE PROJECT IN TERMS OF 19 

HOW PEOPLE UNDERSTAND THE SYSTEM TODAY. NOW, I THINK WE'RE 20 

VERY CONCERNED THAT ANY TYPE OF REMOTE OR ZOOM-BASED WORKSHOP 21 

FORMAT WOULD NOT BE INCLUSIVE OF THE PEOPLE WHO USE OUR 22 

SYSTEM. AND ARE VERY CONCERNED ABOUT HOW WE WOULD BE ABLE TO 23 

BROADLY REACH OUT TO EVERYONE WHO NEEDS TO HAVE AN OPPORTUNITY 24 

TO PARTICIPATE IN THIS CONVERSATION. SO WE HAVE THROWN AROUND 25 
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SOME DISCUSSION ABOUT CAN WE COMMUNICATE WITH COMMUNITY-BASED 1 

ORGANIZATIONS AND ASK THEM TO HELP IDENTIFY INDIVIDUALS WHO 2 

WOULD BE WILLING TO PARTICIPATE, DO WE NEED TO PROVIDE 3 

INCENTIVES AND OFFER PEOPLE SOMETHING IN EXCHANGE FOR THERE 4 

TIME TO PARTICIPATE IN HOUR AND A HALF WORKSHOPS WITH 5 

CONSULTANTS. RIGHT NOW GIVEN THE STATE OF THE PANDEMIC IN THE 6 

BAY AREA I DON'T THINK WE FEEL COMFORTABLE WITH ANY TYPE OF 7 

PERSONAL INTERACTION BUT HOPEFULLY DOWN THE LINE OVER THE 8 

COURSE OF THE PROJECT WE WILL BE ABLE TO ENGAGE IN MORE IN-9 

PERSON INTERACTION AND WHAT ARE THE APPROPRIATE WAYS TO DO 10 

THAT. SO IF YOU CAN GO TO THE NEXT SLIDE HERE. WE HAVE SOME 11 

QUESTIONS, SIMILAR TO WHAT WE DID FOR THE PROBLEM STATEMENT 12 

QUEUED UP HERE JUST TO SORT OF GET THE CONVERSATION GOING BUT 13 

WE DO WANT TO HEAR FROM YOU, SO WHAT ARE THE BEST WAYS TO DO 14 

USER RESEARCH RIGHT NOW DURING THE PANDEMIC. DO YOU HAVE 15 

EXPERIENCE OR LESSONS FROM YOUR ORGANIZATION OR FROM YOUR 16 

CONSTITUENCIES THAT YOU SEE THAT WORK WELL OR DON'T WORK WELL 17 

BECAUSE WE DON'T WANT TO REPEAT MISTAKES AND WE WANT TO LEARN 18 

FROM INTERNAL PROCESSES IN TERMS OF OTHER ENGAGEMENT 19 

ACTIVITIES GOING ON WITH THE BAY AREA AND TRANSIT OPERATOR 20 

LEVEL. HOW DO WE ENGAGE WITH SO MANY PEOPLE SHELTERING IN 21 

PLACE. HOW CAN COMMUNITY-BASED ORGANIZATIONS HELP US? IS THERE 22 

A ROLE FOR THEM OR NOT IS REALLY A QUESTION. AND ARE THERE 23 

GOOD WAYS REALLY TO GAIN THESE INSIGHTS FROM THE PUBLIC RIGHT 24 
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NOW. SO I'LL STOP TALKING, BUT WE LOOK FORWARD TO YOUR 1 

THOUGHTS AND DISCUSSION.  2 

 3 

ADINA LEVIN: YEAH. SO MUCH OF THIS WORLD IS DIFFERENT IN THE 4 

ERA OF THE PANDEMIC. THANK YOU FOR GRAPPLING WITH THIS, AND 5 

LOOKING FORWARD TO THE IDEAS THAT PEOPLE WILL HAVE, WHO HAVE 6 

HANDS RAISED INCLUDING AND STARTING WITH RICH HEDGES.  7 

 8 

RICHARD HEDGES: THANK YOU. JUST A QUESTION. I HAD TO LEAVE THE 9 

ROOM FOR A MOMENT AND I CAME BACK AND HEARD YOU TALKING, 10 

DISCUSSING THE TRANSIT SYSTEM IN TORONTO, DID I HEAR THAT 11 

CORRECTLY?  12 

 13 

WILLIAM BACON: NO, I THINK I MENTIONED TORONTO, BUT VANCOUVER 14 

AND FARE POLICY THERE.  15 

 16 

RICHARD HEDGES: YOU REALIZE THAT IN MOST OF THE CANADIAN 17 

CITIES THE UNDERGROUND SUBWAYS HAVE MILES OF RETAIL THAT LOOK 18 

LIKE SOME OF THE MOST EXPENSIVE SHOPPING CENTERS IN OUR 19 

COUNTRY. IT'S A WHOLE DIFFERENT INTERFACE WITH THE RIDER. I 20 

HAVE USED THE SYSTEMS IN BOTH TORONTO AND IN MONTREAL. IT'S 21 

VERY INTERESTING. I JUST WANT TO CLARIFY THAT, IN MY MIND TO 22 

SEE WHAT KIND OF INFORMATION WE ARE GETTING. SO ANYWAY THAT'S 23 

PRETTY MUCH IT. THANK YOU.  24 

 25 



               July 30, 2020 

 60 

ADINA LEVIN: ALL RIGHT. IF STAFF DOESN'T HAVE ANY COMMENT ON 1 

THAT FROM RICH, WE'LL MOVE ON TO WENDI KALLINS.  2 

 3 

WENDI KALLINS: SO JUST OFF THE TOP OF MY HEAD, A COUPLE OF 4 

IDEAS. I'M WONDERING IF YOU CAN PROVIDE FORMS ON THE TRANSIT 5 

SYSTEMS THAT PEOPLE COULD FILL OUT IF THEY WOULD BE WILLING TO 6 

PARTICIPATE IN A PHONE INTERVIEW, OR FACETIME, ZOOM INTERVIEW, 7 

YOU KNOW, OR A ZOOM MEETING, THAT MIGHT BE ONE WAY TO GATHER 8 

SOME PEOPLE. I THINK IT'S A GOOD IDEA TO REACH OUT TO 9 

ORGANIZATIONS THAT WORK WITH PEOPLE WHO ARE PROBABLY TRANSIT 10 

DEPENDENT, AND MAYBE ALSO LOOKING AT THE END OF THE LINE, IF 11 

THEY'RE ESSENTIAL WORKERS, SOME OF THEM ARE PROBABLY GOING TO 12 

SPECIFIC LOCATIONS, IS YOU MIGHT SEE IF YOU CAN RECRUIT PEOPLE 13 

FROM THOSE LOCATIONS TO TALK TO YOU. ANOTHER THING TO KEEP IN 14 

MIND IS THAT A LOT OF FORM OF TRANSIT USERS WHO WERE 15 

COMMUTERS, NON-ESSENTIAL WORKERS, BUT OFFICE WORKERS MAY NO 16 

LONGER BE COMING BACK TO TRANSIT BECAUSE THEY'RE NOW 17 

CONVERTING TO TELECOMMUTING. I THINK THAT'S A GOOD -- IT MAY 18 

BE GOOD TO REACH OUT TO SOME OF THE RESEARCH ORGANIZATIONS AND 19 

ASSESS WHAT KIND OF LOSS OF TRANSIT IS GOING TO RESULT FROM 20 

THAT. AND HOW MANY PEOPLE -- AND AGAIN, THOSE ARE SOME OF THE 21 

PLACES WHERE YOU MIGHT BE ABLE TO REACH OUT TO PEOPLE WHO USED 22 

TO COMMUTE ON A REGULAR BASIS AND MAY GO BACK TO IT. SO THAT'S 23 

MY BRAINSTORM IDEAS.  24 

 25 
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ADINA LEVIN: ALL RIGHT. EXCELLENT. SO AS WE KEEP THE IDEAS 1 

COMING, ABIGAIL COCHRAN.  2 

 3 

ABIGAIL COCHRAN: HI. THANKS ADINA I AM GOING TO BUILD OFF OF 4 

SOME OF WENDI'S COMMENTS. I THINK THERE IS ABSOLUTELY 5 

OPPORTUNITIES TO GO THROUGH COMMUNITY-BASED ORGANIZATIONS TO 6 

REACH OUT FOR POPULATIONS THAT MAY BE PARTICULARLY VULNERABLE 7 

RIGHT NOW. WITH TRANSIT DEPENDENT POPULATIONS, TO FACILITIES 8 

SENIOR ET CETERA, AND PEOPLE WHO MAY BE UNHOUSED AND PEOPLE 9 

WHO MAY BE USING THOSE ORGANIZATIONS MORE THAN USUAL TO FIGURE 10 

OUT TO GET MESSAGES FROM PUBLIC HEALTH, TRANSIT COMMUNICATES 11 

AND OTHER TYPES OF REALLY IMPORTANT INFORMATION. AND I THINK 12 

THERE IS A LOT OF SCHOLARSHIP ABOUT HOW EMERGENCY RESPONSE IS 13 

-- IN AN EMERGENCY RESPONSE SITUATION RISK COMMUNICATIONS, 14 

REALLY LEVERAGING THE CAPACITY OF THOSE COMMUNITY-BASED 15 

ORGANIZATIONS IS REALLY IMPORTANT AND NOT JUST TRANSPORTATION 16 

AGENCIES AND PROVIDERS. HOWEVER, YOU CAN LEVERAGE 17 

COMMUNICATION CAPACITY OF TRANSPORTATION AGENCIES IN 18 

PARTICULAR WAYS, AND I THINK THAT LEVERAGING COMMUNICATIONS 19 

FROM OPERATORS WHO TALK TO THEIR RIDERS A LOT, FOR INSTANCE 20 

PARATRANSIT OPERATORS. BECAUSE YOU NEED TO CALL TO SCHEDULE 21 

THINGS LIKE THAT, IS A GOOD WAY TO MAKE SURE YOU'RE 22 

DISSEMINATING ACCURATE INFORMATION. ACCURATE INFORMATION AND A 23 

GOOD WAY TO COLLECT INFORMATION FROM RIDERS ABOUT THEIR NEEDS 24 

AND BEHAVIORS RIGHT NOW. THANKS VERY MUCH.  25 
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 1 

ADINA LEVIN: GREAT. SO, LET'S SEE. MOVING ON, BRIAN STANKE. 2 

BRIAN.  3 

 4 

BRIAN STANKE: YES. CAN YOU HEAR ME?  5 

 6 

ADINA LEVIN, CHAIR: YES.  7 

 8 

BRIAN STANKE: GREAT. JUST BUILDING ON SOME OF THE COMMENTS BY 9 

WENDI AND ABIGAIL, THE CITY OF SAN JOSE HAS HAD A LOT OF 10 

SUCCESS BOTH WITH COMMUNITY-BASED ORGANIZATIONS TO DO TARGETED 11 

OUTREACH. AN IMPORTANT LESSON WE LEARNED DOING THAT IS WHEN 12 

YOU INTEGRATE THOSE COMMUNITY-BASED ORGANIZATIONS INTO YOUR 13 

OUTREACH IT'S IMPORTANT TO FAIRLY COMPENSATE THOSE 14 

ORGANIZATIONS FOR THE TIME THAT THEY SPEND HELPING THE 15 

OUTREACH. I ALSO WANT TO SECOND THE IDEA THEY THINK IT -- 16 

THERE ARE CHALLENGES, BUT I THINK IT IS IMPORTANT TO REACH OUT 17 

TO THAT TEN OR 20 PERCENT OF THE RIDERSHIP THAT IS STILL USING 18 

TRANSIT RIGHT NOW, THAT ARE ESSENTIAL WORKERS, THAT ARE 19 

TRANSIT DEPENDENT, THAT IS MOST LIKELY THE DEMOGRAPHIC THAT 20 

YOU WOULD NOT CATCH IF YOU DID A ZOOM MEETING OR ANOTHER 21 

MEETING WHERE YOU WOULD CATCH ON TRANSIT. AND JUST KIND OF 22 

THROWING IN A LAST IDEA, I THINK IT'S MORE OF A CHALLENGE 23 

MAYBE DOING SURVEYING, WHERE YOU ASK IF PEOPLE RODE TRANSIT 24 

BEFORE, AND USE IT TO REPRESENT A CURRENT GROUP OF PEOPLE WHO 25 
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ARE NOT RIDING TRANSIT. COMMUNITY-BASED ORGANIZATIONS AND 1 

REACHING OUT TO THOSE STILL RIDING TRANSIT ARE IMPORTANT TO 2 

GET THAT REPRESENTATIVE EXAMPLE.  3 

 4 

ADINA LEVIN, CHAIR: GREAT. COOL. THE LET'S SEE. THANK YOU. AND 5 

MOVING ON TO RANDI KINMAN.  6 

 7 

RANDI KINMAN: THANK YOU. I HAVE A COUPLE OF THINGS BE TO ADD 8 

TO THE POT. WE CAN ACTUALLY REACH OUT DIRECTLY TO HOMELESS 9 

SHELTERS. THEY HAVE THE CAPACITY TO DO SMALL ZOOM MEETINGS. 10 

THEIR CLIENTELE ARE SHELTER-IN-PLACE AND FAIRLY STABLE. WE 11 

HAVE ONE GROUP IN SUNNYVALE THAT'S ACTUALLY FORMED ITS OWN 12 

HOMELESS UNION, SO TO SPEAK. SO I REALLY WANT US TO BE 13 

REACHING OUT, NOT AS MUCH TO THE CBOS IN THAT CASE, BUT TO THE 14 

ACTUAL PEOPLE WHO ARE USING THE SYSTEM. AND THIS IS, 15 

UNFORTUNATELY, A PRIME OPPORTUNITY FOR US, BECAUSE THEY ARE 16 

SHELTER-IN-PLACE ACROSS OUR ENTIRE REGION. I KNOW URSULA HAS 17 

STARTED WORKING ON THAT WITH PLANNED BAY AREA 2050. ALSO OUR 18 

COMMUNITY COLLEGES -- I'M BACK TO THAT AGAIN -- AND OUR HIGH 19 

SCHOOLS WHERE STUDENTS ARE DEPENDENT AND STAFF ARE DEPENDENT 20 

ON TRANSIT AND TRANSPORTATION, ARE ALL RUNNING A USER LIST 21 

WHERE THERE IS A LARGE AMOUNT OF CONVERSATION GOING ON IT 22 

WOULD BE EASY TO TAP INTO THOSE NETWORKS AND HOLD SMALL FOCUS 23 

GROUP MEETINGS. BEING ABLE TO THROW OUT A SURVEY THAT PEOPLE 24 

CAN USE, WHETHER WE ADVERTISE IT AT TERMINALS, WHETHER WE 25 
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ADVERTISE IT ON THE TRANSIT ITSELF, IF WE CAN TARGET THE HIGH 1 

VOLUME AREAS AROUND HEALTH CARE CENTERS WHERE PEOPLE ARE 2 

GOING, ARE USING TRANSIT, WOULD AT LEAST ALLOW US TO CAPTURE 3 

THOSE RIDERS, AND I KNOW THAT WE'RE GOING TO HAVE A REALLY 4 

HARD TIME CATCHING THE PEOPLE WHO WERE FORMER RIDERS, BUT AT 5 

LEAST WE CAN WORK WITH WHAT WE HAVE GOT. SO THOSE ARE MY 6 

THOUGHTS RIGHT NOW. THANK YOU.  7 

 8 

ADINA LEVIN: OKAY GREAT. I'M GOING TO MOVE TO SOMEONE WHO 9 

HASN'T SPOKEN YET ON THE PANEL, STARTING WITH CAT CARTER.  10 

 11 

CAT CARTER: HI. THANKS. SECOND ALL OF THESE SUGGESTIONS, A LOT 12 

OF THEM ARE ONES I PUT NOTES DOWN TO SAY SOMETHING ABOUT. THEY 13 

ARE GREAT IDEAS. I DON'T KNOW ABOUT OTHER AGENCIES BUT I KNOW 14 

MUNI HAS DONE WELL WITH USING SORT OF DOOR HANGERS ON THE 15 

POLES OF BUSES WHICH IS AN INEXPENSIVE WAY TO REACH RIDERS ON 16 

BUSES SO I WOULD RECOMMEND CHECKING THAT OUT. THERE IS A 17 

SHIFT, OF COURSE, TO TELECOMMUTING AND THERE MAY BE A LOT OF 18 

PEOPLE THAT DON'T GO BACK TO OPPORTUNITY OFFICES BUT I HAVE, 19 

IN OUR CONVERSATIONS WITH SORT OF MAJOR EMPLOYER IN SAN 20 

FRANCISCO AND IN THE AREA WE ARE HEARING THAT A LOT OF PEOPLE 21 

DON'T HAVE GREAT HOME WORKING SITUATIONS AND DON'T WANT TO GO 22 

BACK TO THEIR OFFICES. SOME COMMUTERS WANT TO RETURN. AND 23 

WORKING WITH EMPLOYERS WOULD BE A GOOD WAY AND ALL THOSE 24 

COMPANIES LIKE SALESFORCE ARE DOING THEIR OWN INTERNAL 25 
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SURVEYS. I DON'T KNOW IF THEY WANT TO SHARE BUT THEY'RE 1 

TALKING TO THEIR EMPLOYEES ABOUT THESE ISSUES. AND ANOTHER WAY 2 

TO REACH PEOPLE WHO MAY NORMALLY RIDE BUT AREN'T ARRIVING NOW 3 

BECAUSE THEY'RE SHELTER-IN-PLACE IS GROCERY STORES. TALKING 4 

ABOUT FINDING PEOPLE THAT ARE STILL RIDING BY GOING TO HEALTH 5 

CARE CENTERS MEDICAL CENTERS, BUT ESSENTIAL WORKERS AND A LOT 6 

OF US WHO ARE TELECOMMUTING ARE STILL GOING TO GROCERY STORES 7 

SO IF THERE IS A SURVEY SOMEONE CAN SNAP ON TO THEIR PHONE 8 

WOULD BE GOOD.  9 

 10 

ADINA LEVIN, CHAIR: GOOD IDEAS WE'RE HEARING FROM EVERYBODY. 11 

MOVING ON TO ADRIAN MENDOZA.  12 

 13 

ADRIAN MENDOZA: THANKS. AS A FORMER STUDENT AT SANTA ROSA JR. 14 

COLLEGE THE PAST TWO YEARS, ONE OF THE THING WE HAD WAS 15 

SUBSIDIZED BUS RIDING. IT WAS FREE IF YOU WERE A STUDENT, TO 16 

RIDE. WITH THE STUDENTS SHELTERING IN PLACE AND DISTANCE 17 

LEARNING RIGHT NOW, I THOUGHT PERHAPS SOCIAL MEDIA, IN 18 

ADDITION WITH -- [INDISCERNIBLE] IS ONE WAY OF REACHING THAT 19 

POPULATION. ANOTHER POPULATION THEY WOULD LIKE TO SUBMIT SOME 20 

INFORMATION ABOUT WOULD BE THE LATINOS, SPANISH SPEAKING 21 

POPULATION, AS WELL, TO ENGAGE AND MAKE USE OF THE LOCAL 22 

MEDIA, THE SPANISH LANGUAGE MEDIA, THE BILINGUAL MEDIA, ANY 23 

OTHER POPULATIONS THAT DEAL WITH MULTI-LINGUAL CHALLENGES. AND 24 

SO WITH THE SAME THING, AS I SAID WITH THE STUDENTS, IT'S A 25 
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WAY OF GETTING PEOPLE ENGAGED WHO MIGHT NOT WANT TO 1 

NECESSARILY OTHERWISE LISTEN TO THE MESSAGE THAT IS BEING SENT 2 

OUT. SO THAT'S MY TWO CENTS ON THAT. THANK YOU.  3 

 4 

ADINA LEVIN, CHAIR: THANK YOU. I SEE THAT IT IS 11:55 AND THIS 5 

MEETING IS SCHEDULED TO ADJOURN AT 12. IS IT POSSIBLE TO RUN 6 

THIS UNTIL 12:15 I AM SEEING A COUPLE OF MEMBERS OF THE PUBLIC 7 

WITH THEIR HANDS RAISED AS WELL AS THREE PANELISTS ON THIS 8 

LAST ITEM I REQUEST HELP FROM STAFF ON THE LOGISTICS TO 9 

GETTING TO THE END OF THIS MEETING.  10 

 11 

CLERK OF THE BOARD: MARTHA SPEAKING. THERE IS NO ACTION ITEMS 12 

ON THIS IF WE LOSE QUORUM IF PEOPLE NEED TO DROP OFF WE'RE 13 

OKAY. AND THERE ISN'T A MEETING SCHEDULED TO START AT 12:00 SO 14 

I THINK WOULD BE OKAY. IF PEOPLE NEED TO LEAVE JUST GO AHEAD 15 

AND LEAVE.  16 

 17 

ADINA LEVIN, CHAIR: WE'LL TAKE THE REMAINING HANDS FROM THE 18 

PANELISTS THEN MOVE ON TO THE MEMBERS OF THE PUBLIC. SO TISHA?  19 

 20 

SPEAKER: THANK YOU. I DEFINITELY AGREE THAT REACHING OUT TO 21 

THE COMMUNITY ORGANIZATIONS IS GOING TO BE CRITICAL, BUT THERE 22 

ARE ADDITIONAL WAYS THAT YOU CAN REACH POPULATIONS THAT YOU 23 

WOULDN'T NORMALLY REACH. AND THIS WOULD BE REALLY, I THINK 24 

BENEFICIAL IN UNDERSTANDING HOW YOU CAN INCREASE RIDERSHIP AND 25 
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TO REACH BEYOND WHAT YOU'RE CURRENTLY REACHING IN THIS 1 

ENVIRONMENT I AGREE SOCIAL MEDIA IS GOING TO BE IMPORTANT AND 2 

IN LEVERAGING PRIOR EXPERIENCE IN CORPORATE AMERICA WHEN WE 3 

NEEDED TO REACH BEYOND OUR CURRENT THING, I WOULD RECOMMEND 4 

FACEBOOK SURVEYS. YOU MIGHT NEED TO DO AN INCENTIVE MAYBE A 5 

CUP OF COFFEE MAYBE A FREE RIDE ON THE NEXT TRANSIT. BUT 6 

THAT'S GOING TO GET YOU ALL OF THE RIDERS -- EVEN MY 7 

GRANDMOTHER, SHE'S 83, SHE CAN USE FACEBOOK. THIS IS GOING TO 8 

OPEN UP A BROAD AUDIENCE FOR YOU. SECOND THING, YOU CAN -- 9 

THERE ARE COMPANIES OUT THERE THAT ALLOW YOU TO DO PUSH 10 

NOTIFICATIONS ON PEOPLE'S PHONES WHEN THEY HIT CERTAIN 11 

GEOGRAPHIC SPOTS. SO IF YOU WERE TO ENGAGE THOSE TYPES OF 12 

COMPANIES AND SAY ANY TIME SOMEONE IS WITHIN THE PROXIMITY OF 13 

ONE OF OUR MAJOR TRANSPORTATION, A FERRY, DIFFERENT TYPES OF 14 

ORGANIZATIONS THAT WOULD HOUSE SOME OF THE PARTICIPATING 15 

TRANSPORTATION, YOU COULD HAVE A PUSH NOTIFICATION THAT COULD 16 

POP-UP ASKING WOULD YOU PARTICIPATE IN A SHORT SURVEY. AND 17 

FINALLY GETTING ONE OF THE NINE TRANSIT ORGANIZATIONS TO AGREE 18 

TO PUT A WEB POP-UP SO WHEN YOU GO TO RESEARCH A FARE ON THE 19 

WEB SITE, IF YOU GO TO CLOSE THE WEB SITE OUT A THING POPS UP 20 

AND ASKS DID YOU BUY TODAY AND CERTAIN QUESTIONS. BASICALLY 21 

YOU WOULD HAVE A WAY TO REACH PEOPLE WHO MIGHT BE WALKING AWAY 22 

OTHERWISE. THAT WOULD BE A GOOD WAY TO REACH IN THIS REMOTE 23 

ENVIRONMENT. THANK YOU.  24 

 25 
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ADINA LEVIN, CHAIR: LAST HAND FROM THE PANEL, FROM RICH 1 

HEDGES.  2 

 3 

RICHARD HEDGES: THANK YOU. I LOST MY TRAIN OF THOUGHT LAST 4 

TIME. I WANTED TO COME BACK. I AGREE WITH TISHA THAT FACEBOOK 5 

WOULD BE A GOOD VEHICLE. I WANT TO ADD SOME OTHERS. RANDI 6 

MENTIONED THE HOMELESS I KNOW THAT FROM PRE SET WALKING, THAT 7 

A NUMBER OF AGENCIES THAT COORDINATE HAVE HOMELESS POPULATION, 8 

VOTE, AND THEIR ADDRESS IS THEIR VOTING ADDRESS. SO THAT'S ONE 9 

WAY WE CAN FIND PEOPLE, I THINK. I WANT TO GIVE A SHOUT OUT 10 

FOR ZOOM. MY UNION REPRESENTS PEOPLE THAT MAKE ENTRY LEVEL 11 

FROM 32 TO 35,000 TO 65,000 A YEAR WITH COVERAGE OF PENSIONS 12 

AND HEALTH CARE AND OTHER STUFF BUT THEY'RE NOT HIGH INCOME 13 

PEOPLE. WE HAVE BEEN HOLDING WEEKLY ZOOM MEETINGS WITH THE 14 

PANDEMIC, AND WE HAVE BEEN GETTING HIGH TURN OUT AND THESE ARE 15 

LOW INCOME PEOPLE. ZOOM MIGHT BE THE WAY TO DO IT IF YOU SPACE 16 

IT IN THE RIGHT TIME. BUT ONE THING WE HAVEN'T RAISED IS JUST 17 

ABOUT EVERY CURRENT TRANSIT USER HAS A CLIPPER CARD AND THEY 18 

ALL REGISTER WITH THEIR E-MAIL ADDRESS, AND YOU COULD HAVE 19 

CLIPPER RATHER THAN MTC GATHERING FOR SECURITY REASONS ASK 20 

THEM IF THEY WOULD SEND OUT QUESTIONNAIRES WITH THE ANSWERS 21 

COME BACK TO OUR COMMITTEE AND MTC. CLIPPER IS A GOOD WAY AND 22 

WE COULD DIVIDE IT UP WITH PEOPLE WITH REDUCED FARES AND SO 23 

THERE IS A WAY TO SORT OF SORT OUT THE POPULATIONS WE WANT TO 24 

TALK TO. SO, AND I JUST GIVE TISHA A SHOUT OUT, IT'S NOT OUR 25 
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RESPONSIBILITY RIGHT NOW BUT SAFETY IS AN ISSUE IS IT BEGAN TO 1 

REALLY DRIVE RIDERSHIP DOWN. I HAVE BEEN IN SOME SITUATIONS 2 

THAT WERE VERY UNSAFE ON MAJOR CARRIER BART. SO THAT'S 3 

SOMETHING THAT OUR TRANSIT AGENCIES REALLY HAVE TO FACE IN THE 4 

FUTURE. THANK YOU.  5 

 6 

ADINA LEVIN, CHAIR: ALL RIGHT. THANKS. SO THE ONE THING THEY 7 

WOULD ADD BEFORE MOVING ON TO PUBLIC COMMENT IS THAT THE BAY 8 

AREA IS AN INTERNATIONAL HOT BED OF PROFESSIONAL DISCIPLINE OF 9 

USER RESEARCH, AND I WONDER WHETHER STAFF ALREADY HAS OR COULD 10 

REACH OUT TO SOME OF THE PROFESSIONALS WHO DO THIS WORK WHO 11 

ARE PRESUMABLY HAVING CHALLENGES IN A WIDE RANGE OF DOMAINS, 12 

AND I HAVE A FEW CONTACT IN THAT FIELD, AND CAN HAIL SOME 13 

PEOPLE, BUT THAT MAY BE -- THERE MAY BE SOME OTHER PEOPLE IN 14 

THE FIELD THAT HAVE SOME IDEAS HAVING, YOU KNOW, RUNNING INTO 15 

THIS ALL OVER THE PLACE, BECAUSE OF OUR BROAD CHALLENGES RIGHT 16 

NOW. SO MOVING ON TO PUBLIC COMMENT. FIRST OF ALL, AND I SEE 17 

THREE HANDS FROM MEMBERS OF THE PUBLIC, IF YOU ARE IN, AMONG 18 

THE MEMBERS OF THE PUBLIC, AND YOU WANT TO GIVE A PUBLIC 19 

COMMENT, USE THE RAISED HAND FEATURE, OR DIAL STAR NINE TO BE 20 

IN THE QUEUE TO MAKE AN AUDIO COMMENT. HAS THE CLERK RECEIVED 21 

ANY PUBLIC COMMENTS ASSOCIATED AND IF SO CAN THOSE BE 22 

ASSOCIATED WITH THE RECORD PLEASE  23 

 24 
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CLERK OF THE BOARD: NO PUBLIC COMMENT RECEIVED ON THIS ITEM BY 1 

THE FIVE INCLUDE DEADLINE AND THE FIRST MEMBER OF THE PUBLIC 2 

TO TALK IS PHONE NUMBER ENDING IN 6262. GO AHEAD AND UNMUTE 3 

YOURSELF.  4 

 5 

SPEAKER: HI, THIS IS ROLAND, IN SAN JOSE. SO, I THINK THIS 6 

STARTED VERY WELL, AND WE WERE FOCUSING ON FARE COORDINATION, 7 

BUT SOMEHOW I GOT THE IMPRESSION THAT WE LOST OUR FOCUS AS 8 

THINGS WENT ON HERE TODAY. BASICALLY THERE ARE THREE THREADS 9 

HERE AND THIS SHOULD BE HANDLED SEPARATELY, EQUITY, AND THEN 10 

OBVIOUSLY INTEGRATING THE SYSTEMS, AND INTERFACE. AND 11 

INTERFACE AND FARES IS WHAT WE SHOULD BE FOCUSING ON NOW. 12 

SLIDES 6 AND 7 TALKING ABOUT FARES IN THE BAY AREA, AND THERE 13 

ARE SOME LOW HANGING FRUITS IN THERE, LIKE WHY DO WE HAVE NINE 14 

DIFFERENT LOCAL BUS FARES AND CLIPPER. LET'S TAKE CARE OF THIS 15 

RIGHT AWAY. I DON'T THINK THAT WOULD BE DIFFICULT. 16 DISCOUNT 16 

RATES FOR YOUTH, 14 FOR SENIORS LET'S TAKE THAT AWAY. TRIPS 17 

SAME DISTANCE AND MODE CAN VARY DRAMATICALLY IN PRICE, AND 18 

YES, THAT IS NOT AN ISSUE, THAT IS THE WAY IT IS. SO NOW YOU 19 

MOVE ON TO THE PREVIOUS SLIDE, TALKING ABOUT FLAT FARES FOR 20 

SEVEN OPERATORS. AND THEN TALKING ABOUT ZONE BASED. IN LONDON 21 

EVERYTHING IS ZONE BASED. BUT THE THINGS THAT YOU GOT TO 22 

UNDERSTAND, IS THAT IF AN OPERATOR -- CAN YOU HEAR ME? -- EVEN 23 

OPERATOR, OPERATOR WAS IN ONE ZONE, THAT OPERATOR BY DEFAULT 24 

IS FLAT FARE WITHIN THE ZONE. YOU KNOW IT'S NOT DIFFICULT TO 25 
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UNDERSTAND. NOW, WHEN IT GETS TO THE POINT OF PEOPLE -- 1 

BASICALLY TIME IS MONEY, AND THEY PAY FOR WHAT THEY GET -- 2 

THIS IS WHY EXPRESS BUSES COST TWICE AS MUCH AS ORDINARY BUSES 3 

BECAUSE THEY TAKE YOU WHERE YOU WANT TO GET IN HALF OF TIME. 4 

AND THAT'S THE SAME THING WITH CALTRAIN AND BART THAT'S WHY 5 

YOU PAY A PREMIUM. THESE SYSTEMS ARE DEDICATED, ARE MUCH MORE 6 

EXPENSIVE TO OPERATE THAN BUSSES AND ROADS. AND LAST THING I 7 

WANT TO POINT OUT TO YOU WHAT'S MISSING FROM THE PRESENTATION 8 

IS THE FUNDING SOURCES. YES, YOU TALK ABOUT THE FARES, BUT YOU 9 

DID NOT TALK ABOUT HOW ALL THE SYSTEMS USE DIFFERENT FUNDING 10 

SOURCES. THANK YOU.  11 

 12 

CLERK OF THE BOARD: OKAY. NEXT UP IS CHRISTINA GOTUACO. GO 13 

AHEAD AND UNMUTE YOURSELF.  14 

 15 

CHRISTINA GOTUACO: HI CHRISTINA IN SAN FRANCISCO AND A MEMBER 16 

OF THE POLICY ADVISORY COUNCIL. I JUST WANT TO -- SORRY -- OH 17 

I JUST WANT TO SAY, AT MINIMUM, I HOPE THAT EXISTING AVENUES 18 

ARE AUTOMATIC, SUCH AS TRANSIT AGENCY WEB SITES AS TISHA SAID, 19 

AND THE CLIPPER E-MAIL LIST SERVE AS RICH WAS MENTIONING TO 20 

ALSO ADD LIST OF SERVE TRANSIT OPERATORS WHO OPERATE ANY PASS 21 

HOLDER PROGRAMS, AC TRANSIT EASY TRANSIT PASSES AS WELL AS 22 

TRANSIT HUBS, SIGNAGE CASES FOR SCHEDULES HAVE SPACE FOR OTHER 23 

ADVERTISING AND ANNOUNCEMENTS OR ON THE SCREENS THAT ARE IN 24 

STATIONS. I THINK -- I ONLY HEARD REALLY FROM BRIAN AND RANDI 25 
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AND CAT ABOUT OUTREACH TO CURRENT RIDERS. THERE ARE STILL 1 

PEOPLE RIDING THE BUSSES AND TRAINS TODAY, AND I THINK THE 2 

RICHEST DATA WILL COME FROM LIVE RIDERS THEMSELVES. ESPECIALLY 3 

IF YOU ARE ABLE TO JUST HAND THEM A PIECE OF PAPER OR OFFER 4 

THEM AN ONLINE INTERFACE, WHERE THEY CAN JUST LOG THEIR SYSTEM 5 

RIDES, LIKE MAYBE JUST DO A WEEK LONG DIARY OF WHAT THEY'RE 6 

RIDING, WHERE THEY'RE GETTING ON, WHERE THEY'RE GETTING OFF, 7 

AND HOW THEY'RE PAYING FOR EACH MODE THAT THEY'RE TAKING. IF 8 

WE WERE EVEN TO DO THAT ACROSS MAYBE OUTREACH TO LIKE FOUR OR 9 

500 CURRENT RIDERS AND TARGET SO THERE IS A PROPORTIONAL 10 

REPRESENTATION FROM EACH TRANSIT AGENCY I THINK THAT WOULD 11 

PROVIDE RICH DATA ABOUT CURRENT FARES BEING, AND HOW THEY'RE 12 

AFFECTING CURRENT RIDERS AND THEN THOSE PEOPLE COULD BE 13 

INVITED TO PARTICIPATE IN AN HOUR LONG WORKSHOP AND THEN THEY 14 

WOULD HAVE VESTED INTEREST SINCE THEY HAVE BEEN DOING THEIR 15 

ETHNIC GRAPHIC RESEARCH. THANK YOU.  16 

 17 

CLERK OF THE BOARD: NEXT UP IS ALETA DUPREE.  18 

 19 

SPEAKER: THANK YOU CHAIRPERSON ADINA LEVIN AND MEMBERS. ALETA 20 

DUPREE FOR THE RECORD. THIS IS VERY COMPREHENSIVE. VERY WELL 21 

THOUGHT OUT. IT'S HEAVY. I REALLY APPRECIATED THE CHART WITH 22 

ALL OF THE DIFFERENT FARE POSSIBILITIES ACROSS THE BAY AREA. 23 

AND I THINK THAT A WORK-UP OF WHAT A PROPOSED FARE INTEGRATION 24 

SCHEDULE SHOULD LOOK LIKE, APPORTIONMENT IS A MAJOR PART OF A 25 
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FARE INTEGRATION IN THAT EACH SYSTEM GETS THEIR DUE, CONSIDER 1 

THE INTERNATIONAL FUEL TAX AGREEMENT, WHICH IS A MECHANISM 2 

USED TO APPORTION FUEL TAXES PAID BY TRUCKING COMPANIES BASED 3 

ON MILEAGE AND FUEL PURCHASES IN EACH STATE. I THINK WE SHOULD 4 

ALSO LOOK AT SYSTEMS IN OTHER AREAS. CLOSEST I HAVE COME TO 5 

FARE INTEGRATION IS USING TRANSIT IN PORTLAND, USING THE HOPP 6 

FAST PASS APPLICATION. AND CHICAGO HAS A SMALL INTEGRATIVE 7 

APPEARING SYSTEM BETWEEN THE CTA, WHICH OPERATES THE L, AND 8 

THE SUBURBAN BUS LINE KNOWN AS PACE. IN NEW YORK, YOU CAN 9 

SPEND $2.75 SENDS TO RIDE SUBWAY TO PARTS OF THE CITY, BUT 10 

YOU'RE GOING TO PAY 2 TO 3 TIMES AS MUCH TAKING THE RAILROAD, 11 

AND SO THERE IS A DIFFERENCE IN GOING FROM NEW YORK, PEN 12 

STATION TO NEWARK ON MJ TRANSIT OR IF YOU WALK ONE BLOCK TO 13 

HAROLD SQUARE AND GO TO NEWARK USING PATH OR YOU CAN GO FROM 14 

THE BRONX TO MANHATTAN ON THE SUBWAY FOR $2.75 BUT YOU'RE 15 

GOING TO PAY MORE IF YOU GO FROM THE BRONX ON METRO NORTH TO 16 

GRAND CENTRAL TERMINAL. I THINK WE SHOULD LOOK AT SYSTEMS AND 17 

HOW THEY'RE DOING IT OR NOT DOING IT. THANKS.  18 

 19 

CLERK OF THE BOARD: THAT WAS OUR LAST SPEAKER THERE ARE NO 20 

OTHER MEMBERS OF THE PUBLIC WITH THEIR HANDS RAISED.  21 

 22 

ADINA LEVIN, CHAIR: ALL RIGHT. THANK YOU VERY MUCH. THANKS 23 

VERY MUCH TO STAFF, THAT THIS GROUP HAS PROVIDED YOU WITH FOOD 24 

FOR IMPROVING THE USER RESEARCH AND REFINING THE STUDY. MOVING 25 
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ON TO AGENDA ITEM NUMBER FIVE, NEW BUSINESS, NOW IS THE POINT 1 

IN THE AGENDA WHERE MEMBERS OF THE SUBCOMMITTEE MAY BRING UP 2 

NEW BUSINESS FOR DISCUSSION OR ADDITION FOR A FUTURE AGENDA. 3 

SO PLEASE RAISED YOUR HAND IF YOU HAVE ANY ITEMS OF NEW 4 

BUSINESS THAT YOU WOULD LIKE TO PUT INTO THE HOPPER HERE. AND 5 

I SEE THAT RANDI KINMAN HAS A HAND.  6 

 7 

RANDI KINMAN: THANK YOU. I JUST WANT TO MAKE SURE THAT WE HAVE 8 

A KNOWN FORMAT FOR MAKING SURE THAT THIS GROUP SEES THE 9 

MATERIAL BEFORE IT GOES TO THE BIG TASK FORCE, AND THAT WE 10 

HAVE ALL THOSE SCHEDULES COMING UP. THAT'S MY ASK. THANK YOU.  11 

 12 

ADINA LEVIN: OKAY. THANK YOU. AND OTHER ITEMS OF NEW BUSINESS 13 

THAT ANYBODY HAS HERE? I AM NOT SEEING ANY HANDS. SO WE WILL 14 

MOVE TO THE NEXT ITEM HERE, WHICH IS PUBLIC COMMENT ON ANY 15 

OTHER BUSINESS. I'LL ASK TO READ NAMES OR ORGANIZATIONS OF 16 

GENERAL WRITTEN PUBLIC COMMENTS RECEIVED AT 17 

INFO@BAYAREAMETRO.GOV INTO THE RECORD AND ANYONE PARTICIPATING 18 

IN GENERAL COMMENT ON ITEMS NOT ON TODAY AGENDA PLEASE USE THE 19 

RAISED HAND OR DIAL STAR NINE AND I'LL CALL UPON YOU TO SPEAK. 20 

WERE THERE ANY OTHER WRITTEN COMMENTS SUBMITTED?  21 

 22 

CLERK OF THE BOARD: NO WRITTEN COMMENT RECEIVED ON THIS ITEM 23 

HOWEVER ROLAND LEBRUN HAS HIS HAND RAISED FOR THIS ITEM. 24 

ROLAND.  25 
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 1 

SPEAKER: YEAH. THANK YOU. VERY BRIEFLY. IT'S TO DO -- AND I 2 

APOLOGIZE FOR THE NOISE, THE GARBAGE IS RIGHT OUTSIDE MY HOUSE 3 

RIGHT NOW -- THE WAY THE PACKET IS ORGANIZED, EVERYTHING IS 4 

BUNGLED TOGETHER, AND THEN THERE IS MASSIVE SPREADSHEET IN THE 5 

MIDDLE, THAT BASICALLY TALKS ABOUT THE VARIOUS AGENCIES, THAT 6 

ARE BASICALLY TRYING TO PACK IT COMPLETELY OUT OF WHACK SO I 7 

WAS WONDERING IF MOVING FORWARD IF IT WOULD BE POSSIBLE TO 8 

HAVE THE NARRATIVES, YOU KNOW, IN A SEPARATE PDF, OF THE 9 

PRESENTATION, A SEPARATE PDF THEN WHEN YOU HAVE THE AUTOMATIC 10 

SPREADSHEET LIKE THAT IF ONCE AGAIN IT COULD BE ON ITS OWN 11 

WHEN IT'S POSTED ON THE LEDGE STAR. THANK YOU.  12 

 13 

ADINA LEVIN: ALL RIGHT. IF THERE ARE NO OTHER MEMBERS OF THE 14 

PUBLIC WHO WOULD LIKE TO SPEAK ON THIS ITEM, WE WOULD LIKE TO 15 

MOVE ON TO ITEM NUMBER SEVEN --  16 

 17 

SPEAKER: [INDISCERNIBLE].  18 

 19 

CLERK OF THE BOARD: THERE IS ONE MORE MEMBER OF THE PUBLIC 20 

THAT JUST RAISED THEIR HAND.  21 

 22 

ADINA LEVIN, CHAIR: ALL RIGHT.  23 

 24 

CLERK OF THE BOARD: ALETA GO AHEAD AND UNMUTE YOURSELF.  25 
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 1 

SPEAKER: THANK YOU CHAIR, ADINA LEVIN AND MEMBERS. ALETA 2 

DUPREE FOR THE RECORD. THANK YOU. I LOOK FORWARD TO GETTING 3 

TOGETHER AGAIN. IN THE BROADER SCOPE, I FEEL THIS WORK OF FARE 4 

INTEGRATION, I WOULD HOPE, TO HELP ADVANCE LARGER 5 

CONVERSATIONS ABOUT HOW PEOPLE INTERACT BOTH FINANCIALLY AND 6 

IN COMMUNICATES IN RELATIONSHIPS WITH TRANSIT SYSTEMS. THERE'S 7 

A COIN SHORTAGE GOING ON RIGHT NOW. AND SO WITH VEHICLES SUCH 8 

AS CLIPPER AND APPS, HOPEFULLY WE CAN ENCOURAGE PEOPLE TO TAKE 9 

THEIR COINS DOWN TO THE BANK OR TO A SUPER MARKET COIN HOPPER 10 

AND DROP THEM IN AND TRANSFER THAT MONEY OVER SO THEY CAN RIDE 11 

TRANSIT AND GET THOSE COINS IN THE SYSTEM AND MOVE PAST THAT. 12 

SO, EQUITY, OBVIOUSLY, IS IMPORTANT. BECAUSE IN ORDER TO HAVE 13 

MORE OPTIONS, IT SHOULDN'T JUST BE ABOUT OPTIONS THAT ARE 14 

THERE, SUCH AS WHEN I MENTIONED BEFORE ABOUT MJ TRANSIT VERSUS 15 

PATH OR AMTRAK OR METRO NORTH VERSUS SUBWAY. BUT OPTIONS TRULY 16 

BECOME AVAILABLE WHEN THE PRICING OF THOSE OPTIONS IS SIMILAR, 17 

RATHER THAN STARKLY DIFFERENT. AND SO WE CAN OPEN UP MORE 18 

CAPACITY, ESPECIALLY IF YOU HAVE AN EMPTY RAILROAD TRAIN GOING 19 

TO THE SAME PLACE AS A CROWDED SUBWAY. WE CAN MOVE SOME OF 20 

THOSE PEOPLE OFF THE CROWDED SUBWAY ON TO THE EMPTY RAILWAY. 21 

SO IT IS IMPORTANT TO HAVE EQUITY ON THE TABLE, JUST AS I HOPE 22 

WE CAN BE A VOICE FOR HELPING, ESPECIALLY THE UNBANKED TO BE 23 

ABLE TO ENGAGE WITH TRANSIT WITHOUT HAVING TO CARRY MONEY 24 

AROUND OR PAY HIGH FEES FOR FINANCIAL SERVICES. THANK YOU.  25 
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 1 

ADINA LEVIN, CHAIR: OKAY. ARE THERE ANY OTHER MEMBERS OF THE 2 

PUBLIC WHO WISH TO SPEAK AT THIS TIME?  3 

 4 

CLERK OF THE BOARD: THERE ARE NO MORE MEMBERS OF THE PUBLIC 5 

WITH THEIR HANDS RAISED.  6 

 7 

ADINA LEVIN, CHAIR: ALL RIGHT. THANKS TO EVERYBODY WHO HAS 8 

COME IN TO SHARE YOUR THOUGHTS WITH STAFF. AGENDA ITEM SEVEN 9 

IS ADJOURNMENT TO THE NEXT MEETING. THE NEXT MEETING OF THE 10 

POLICY ADVISORY COUNCIL FARE COORDINATION AND INTEGRATION 11 

SUBCOMMITTEE WILL BE AT A TIME TO BE DULY NOTICED. THANK YOU 12 

VERY MUCH. AND SEE YOU AT THAT DULY NOTICED TIME. [ADJOURNED]  13 

 14 


